TOS PROTOCOL AND PROCEDURE:
PLOT ESTABLISHMENT

<table>
<thead>
<tr>
<th>PREPARED BY</th>
<th>ORGANIZATION</th>
<th>DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rachel Krauss</td>
<td>FSU</td>
<td>01/01/2018</td>
</tr>
<tr>
<td>Kate Murphy</td>
<td>FSU</td>
<td>01/01/2018</td>
</tr>
<tr>
<td>David Barnett</td>
<td>FSU</td>
<td>01/01/2018</td>
</tr>
<tr>
<td>Courtney Meier</td>
<td>FSU</td>
<td>01/01/2018</td>
</tr>
<tr>
<td>Mike Patterson</td>
<td>FSU</td>
<td>01/11/2017</td>
</tr>
<tr>
<td>Sean Hauser</td>
<td>FOPS</td>
<td>10/23/2015</td>
</tr>
<tr>
<td>Ben Vierra</td>
<td>FOPS</td>
<td>10/23/2015</td>
</tr>
<tr>
<td>Carol Goranson</td>
<td>FOPS</td>
<td>10/23/2015</td>
</tr>
<tr>
<td>Elena Azuaje</td>
<td>FSU</td>
<td>12/04/2014</td>
</tr>
<tr>
<td>Jalynda McKay</td>
<td>FSU</td>
<td>11/28/2014</td>
</tr>
<tr>
<td>Katie Jones</td>
<td>FSU</td>
<td>03/28/2014</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>APPROVALS</th>
<th>ORGANIZATION</th>
<th>APPROVAL DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kate Thibault</td>
<td>SCI</td>
<td>01/03/2019</td>
</tr>
<tr>
<td>Mike Stewart</td>
<td>SYS</td>
<td>12/26/2018</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RELEASED BY</th>
<th>ORGANIZATION</th>
<th>RELEASE DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anne Balsley</td>
<td>CM</td>
<td>01/08/2019</td>
</tr>
</tbody>
</table>

See configuration management system for approval history.

The National Ecological Observatory Network is a project solely funded by the National Science Foundation and managed under cooperative agreement by Battelle. Any opinions, findings, and conclusions or recommendations expressed in this material are those of the author(s) and do not necessarily reflect the views of the National Science Foundation.
Change Record

<table>
<thead>
<tr>
<th>REVISION</th>
<th>DATE</th>
<th>ECO #</th>
<th>DESCRIPTION OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>01/10/2014</td>
<td>ECO-01139</td>
<td>Draft release</td>
</tr>
<tr>
<td>B</td>
<td>03/28/2014</td>
<td>ECO-01663</td>
<td>Production release, template change, and other changes as detailed in Appendix A</td>
</tr>
<tr>
<td>C</td>
<td>10/15/2014</td>
<td>ECO-02355</td>
<td>Migration to new protocol template</td>
</tr>
<tr>
<td>D</td>
<td>02/23/2015</td>
<td>ECO-02566</td>
<td>• GPS Receiver Setup edits; A-3.C and A-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Extraction of the Rangefinder section to NEON.DOC.001717</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Shifting and Offsetting Point Locations; SOP B.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Information located in boxes has been embedded in protocol text.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added NEON Criteria for Wet Locations to Appendix D</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Updated Appendix E: general workflow, tower workflow, mammal workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Delineation steps where reformatted</td>
</tr>
<tr>
<td>E</td>
<td>1/29/2016</td>
<td>ECO-03061</td>
<td>• Replaced the word ‘TruePulse’ to rangefinder across the document.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Rewording in Section 1.1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Additional details added about RRQRR sequence to section 3 in the Methods.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A.8 added site specific plot information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Metadata collection was moved to B.4.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• F.2 Lost Plot Markers section added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• G.1 Legend of figure was edited.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• SOP H Plot Monumentation and Appendix I were added to clarify steps and safety concerns</td>
</tr>
<tr>
<td>F</td>
<td>03/20/2017</td>
<td>ECO-04429</td>
<td>• Added ear plugs to the equipment list</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Appendix J- Base Station Workflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Appendix A - Updated log sheets</td>
</tr>
<tr>
<td>G</td>
<td>03/16/2018</td>
<td>ECO-05482</td>
<td>• Update SOPF.2: Lost Plot Marker- Approved by Science and Ops IPT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Removed broken links</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Appendix A- Fixed primary marker location in A.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Appendix B- Added base station table</td>
</tr>
<tr>
<td>H</td>
<td>01/08/2019</td>
<td>ECO-05961</td>
<td>• Added instructions for SD card file transfer in sections A.5 and E1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Cleaned up graphics in Appendix D</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added notes from FOPs for section F2</td>
</tr>
</tbody>
</table>
TABLE OF CONTENTS

LIST OF TABLES AND FIGURES ........................................................................................................... III

1 OVERVIEW ......................................................................................................................................... 1
   1.1 Background ................................................................................................................................... 1
   1.2 Scope ............................................................................................................................................. 2
       1.2.1 NEON Science Requirements and Data Products ................................................................. 2
   1.3 Acknowledgments ......................................................................................................................... 2

2 RELATED DOCUMENTS AND ACRONYMS .....................................................................................3
   2.1 Applicable Documents .................................................................................................................. 3
   2.2 Reference Documents ................................................................................................................... 3
   2.3 Acronyms ...................................................................................................................................... 4
   2.4 Definitions ..................................................................................................................................... 4

3 METHOD ....................................................................................................................................5
   3.1 NLCD Vegetation Classification ..................................................................................................... 6

4 SCHEDULE ..................................................................................................................................8
   4.1 Frequency and Timing ................................................................................................................... 8
   4.2 Criteria for Determining Establishment Dates .............................................................................. 8
   4.3 Timing for Laboratory Processing and Analysis ............................................................................ 8
   4.4 Sampling Timing Contingencies .................................................................................................... 8

TABLE 2. CONTINGENT DECISIONS ...................................................................................................... 8

5 SAFETY .......................................................................................................................................9

6 PERSONNEL AND EQUIPMENT ................................................................................................... 10
   6.1 Equipment ................................................................................................................................... 10
   6.2 Training Requirements ................................................................................................................ 15
   6.3 Specialized Skills .......................................................................................................................... 15
   6.4 Estimated Time ........................................................................................................................... 15

7 STANDARD OPERATING PROCEDURES FOR TOS PLOTS ............................................................... 16
   7.1 Workflow of Plot Establishment Activities .................................................................................. 17
SOP A PREPARING FOR ESTABLISHMENT ...................................................................................... 18
SOP B PLOT ACCEPTANCE ............................................................................................................... 28
SOP C  PLOT DELINEATION AND MARKING ................................................................. 39
SOP D  COLLECT GPS COORDINATES ................................................................. 48
SOP E  DATA ENTRY AND VERIFICATION ........................................................... 53
SOP F  RE-VISITING GPS LOCATIONS ............................................................... 60
SOP G  SAMPLE SHIPMENT ............................................................................... 73
SOP H  PLOT MONUMENTATION ................................................................. 74

8  REFERENCES ...................................................................................................... 79

APPENDIX A  LOG SHEETS .............................................................................. 80
APPENDIX B  GPS RECEIVER SETUP ............................................................... 92
APPENDIX C  CRITERIA FOR PLOT ESTABLISHMENT IN WET LOCATIONS ... 98
APPENDIX D  PLOT ESTABLISHMENT WORKFLOWS ..................................... 99
APPENDIX E  NLCD VEGETATION CLASSIFICATION DESCRIPTION .............. 109
APPENDIX F  PLOT DELINEATION LAYOUT ..................................................... 111
APPENDIX G  SCHEMATIC OF COMPLETE GRID USED TO LABEL PLOT POINTS 113
APPENDIX H  TROUBLESHOOTING ................................................................. 114
APPENDIX I  PLOT MONUMENT INSTALLATION JSA ........................................ 117
APPENDIX J  BASE STATION WORKFLOW ....................................................... 119
LIST OF TABLES AND FIGURES

Table 1. The NLCD land use and land cover classification system for use with remote sensing data. ....... 6
Table 2. Contingent decisions......................................................................................................................................... 8
Table 3. Equipment list – A crew of two technicians preparing for establishment of one plot ............. 10
Table 4. Equipment list – A crew of two technicians performing field establishment of one plot ........ 11
Table 5. Materials provided for use of FOPs and Science. These folders are located in the designated drive; the specific organization of these folders is not outlined in this table. .................................................................................. 18
Table 6. Points to be logged by FOPS (also see workflow for each plot type in Appendix D) ........... 49
Table 7. Base station equipment list ........................................................................................................ 120

Figure 1. Generalized site-scale sampling schematic for the NEON Terrestrial Observation System (TOS) .................................................................................................................................................................... 16
Figure 2. Pathfinder Office project ............................................................................................................. 22
Figure 3: Data Transfer Symbol ................................................................................................................. 24
Figure 4: GPS Pathfinder Device ........................................................................................................... 25
Figure 5: GPS Pathfinder Device Selection .......................................................................................... 25
Figure 6: GPS Pathfinder Connection ................................................................................................... 26
Figure 7: GPS Pathfinder, "Send" ........................................................................................................... 26
Figure 8: Terra Sync, SD card ................................................................................................................ 26
Figure 9. Plot Delineation step 1 ........................................................................................................ 40
Figure 10. Plot Delineation step 2 ........................................................................................................ 41
Figure 11. Plot Delineation Step 3 ........................................................................................................ 42
Figure 12. Plot Delineation Step 4 ........................................................................................................ 42
Figure 13. Plot layout and marker positions for 40 m by 40m Distributed Base Plots .................... 46
Figure 14. GeoXH 6000 set up for high accuracy data collection ..................................................... 48
Figure 15: GPS Pathfinder Data Transfer ............................................................................................. 53
Figure 16: GPS Pathfinder, GIS Folder ................................................................................................. 54
Figure 17: Data Transfer .......................................................................................................................... 54
Figure 18: Data Transfer .ssf Files ........................................................................................................... 55
Figure 19. The Obstructions tool within the Trimble Mission Planning web-based software .......... 57
Figure 20. Adding an obstruction observed in the field within the Trimble Mission Planning software.. 58
Figure 21. Lost Plot Marker Workflow. Note: CEA = Current Estimated Accuracy ......................... 62
Figure 22. Trimble Wi-Fi symbol setup ............................................................................................... 66
Figure 23. Trimble Wi-Fi symbol ........................................................................................................... 67
Figure 24. Connection and CEA Locations ......................................................................................... 69
Figure 25. Distances and azimuths between points ................................................................................... 70
Figure 26. Splitting the delineation difference ....................................................................................... 71
Figure 27. Removing pre-existing plot markers with a pry bar ......................................................... 74
Figure 28. Do not allow the monument assembly sections to become separated while striking ....... 75
Figure 29. Do not lift the post diver above the top of the rod during the striking motion as the worker could injure their leg or hand ................................................................. 76
Figure 30. Use a sledgehammer to seat the cap and drive the rod to the desired position .............. 77
Figure 31. Example of how to use a plot maintenance log sheet .................................................. 81
Figure 32. GPS receiver Geo XH 6000 ......................................................................................... 92
Figure 33. Schematic of the point ID grid .................................................................................... 113
Figure 34. Alternative strategy when obstructions are in line of sight during plot delineation ......... 115
Figure 35. Hypotenuse option to verify plot delineation measurements ......................................... 116
Figure 36. Base station equipment ................................................................................................. 122
Figure 37. Base station setup ......................................................................................................... 122
Figure 38. Setting up a new job ..................................................................................................... 123
Figure 39. Base mode highlighted orange ..................................................................................... 124
Figure 40. Battery status display .................................................................................................. 125
Figure 41. Entering site specific information .................................................................................. 125
Figure 42. Entering the spatial information .................................................................................... 126
Figure 43. RINEX Conversion ....................................................................................................... 128
Figure 44. RINEX metadata .......................................................................................................... 129
Figure 45. OPUS Report ............................................................................................................... 130
1 OVERVIEW

1.1 Background

The National Ecological Observatory Network’s (NEON) goal is to improve understanding and forecasting of ecological change at continental scales over decades (Schimel et al. 2011). The design co-locates measurements of atmosphere, soil, water, select organisms and disease, and airborne observations. Observing change by integrating measures of the drivers and ecological responses will contribute to improved understanding of ecological cause and effect (Vitousek 1997, Keller et al. 2008, Luo et al. 2011). High-level requirements derived from the NEON goal and mission guide the architecture of the design and infrastructure for the national Observatory (Schimel et al. 2011). The primary requirement-driven constraint of the design is that it must assemble sufficient data collected at points and local regions (400-km²) to enable extrapolation of these functional relationships to the scale of the continent over the course of several decades. The requirements framework permeates the NEON design, providing guidance for the design of observations and direct linkages back to the NEON mission.

A suite of measurements that cross temporal and spatial scales will describe the ecological status and future trends NEON is designed to detect. Fixed-wing aircraft measure the landscape across NEON sites with high-resolution remote sensing, and tower-based sensors capture temporally continuous fluxes over smaller spatial extents. However, neither approach is sufficient for terrestrial biogeochemistry and organismal observations. A complete census of these measures at each site is biologically and financially impractical – microbes are ubiquitous and birds are mobile. Measurement of these types of ecological responses at sensor-like temporal frequencies is impossible, and even frequent observations at local scales would likely provide redundant information or, due to financial constraints, be limited in spatial extent. Hence, terrestrial organisms and soil will be measured at discrete temporal and spatial units by human observers carrying out field-based observations.

The diversity of biogeochemistry and organismal measurements presents a formidable challenge to the integrated collection of data for the Observatory. Measurements include biodiversity, phenology, biomass, stoichiometry, prevalence of disease, and genomics of soil and organisms with a range of life histories and phylogenetic traits (Keller et al. 2008). Components of each will be targeted for observation with a sample design (Thompson 2012). The design must collect data that capture spatial variability, facilitate the integration of observations, allow inference to unsampled populations, and contribute to ecological insight at large spatio-temporal scales. The Spatial Sampling Science Design (RD[15]) describes the proposed strategy: guided by NEON principles and requirements, the terrestrial sampling design provides a data collection framework that is statistically rigorous, operationally efficient, flexible, and readily facilitates integration with other data to advance the understanding of the drivers of and responses to ecological change. This protocol describes how to implement this design by creating plots on the ground at NEON sites where the observations that inform the Observatory will be made.
1.2 Scope

This document provides a change-controlled version of Observatory protocols and procedures. Documentation of content changes (i.e. changes in particular tasks or safety practices) will occur via this change-controlled document, not through field manuals or training materials.

1.2.1 NEON Science Requirements and Data Products

This protocol fulfills Observatory science requirements that reside in NEON’s Dynamic Object-Oriented Requirements System (DOORS). Copies of approved science requirements have been exported from DOORS and are available in NEON’s document repository, or upon request.

Execution of this protocol procures samples and/or generates raw data satisfying NEON Observatory scientific requirements. These data and samples are used to create NEON data products, and are documented in the NEON Scientific Data Products Catalog (RD[03]).

1.3 Acknowledgments

This protocol relies heavily on advice and field experience provided by Dr. Benjamin Chemel with the Northern Rockies Conservation Cooperative.
## RELATED DOCUMENTS AND ACRONYMS

### 2.1 Applicable Documents

Applicable documents contain higher-level information that is implemented in the current document. Examples include designs, plans, or standards.

| AD[01] | NEON.DOC.004300 | EHSS Policy, Program and Management Plan |
| AD[02] | NEON.DOC.004316 | Operations Field Safety and Security Plan |
| AD[03] | NEON.DOC.000724 | Domain Chemical Hygiene Plan and Biosafety Manual |
| AD[04] | NEON.DOC.050005 | Field Operations Job Instruction Training Plan |
| AD[05] | NEON.DOC.004104 | NEON Science Performance QA/QC Plan |

### 2.2 Reference Documents

Reference documents contain information that supports or complements the current document. Examples include related protocols, datasheets, or general-information references.

| RD[01] | NEON.DOC.000008 | NEON Acronym List |
| RD[02] | NEON.DOC.000243 | NEON Glossary of Terms |
| RD[03] | NEON.DOC.002652 | NEON Level 1, Level 2 and Level 3 Data Products Catalog |
| RD[04] | NEON.DOC.001271 | NEON Protocol and Procedure: Manual Data Transcription |
| RD[05] | NEON.DOC.014049 | TOS Protocol and Procedure: Mosquito Sampling |
| RD[08] | NEON.DOC.000906 | TOS Science Design for Terrestrial Biogeochemistry |
| RD[09] | NEON.DOC.000907 | TOS Science Design for Plant Phenology |
| RD[10] | NEON.DOC.000908 | TOS Science Design for Microbial Diversity |
| RD[12] | NEON.DOC.000910 | TOS Science Design for Mosquito Abundance, Diversity and Phenology |
| RD[13] | NEON.DOC.000911 | TOS Science Design for Vectors and Pathogens |
| RD[14] | NEON.DOC.000912 | TOS Science Design for Plant Diversity |
| RD[15] | NEON.DOC.000913 | TOS Science Design for Spatial Sampling |
| RD[16] | NEON.DOC.000914 | TOS Science Design for Plant Biomass, Productivity, and Leaf Area Index |
| RD[17] | NEON.DOC.000915 | TOS Science Design for Small Mammal Abundance and Diversity |
| RD[18] | NEON.DOC.000916 | TOS Science Design for Breeding Bird Abundance and Diversity |
| RD[20] | NEON.DOC.002649 | NEON Configured Site List |
2.3 Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>HD</td>
<td>Horizontal Distance</td>
</tr>
<tr>
<td>MDD</td>
<td>Main Drop Down (menu icon in GPS receiver)</td>
</tr>
<tr>
<td>SDD</td>
<td>Sub Drop Down (menu icon in GPS receiver)</td>
</tr>
<tr>
<td>NLCD</td>
<td>National Land Cover Database</td>
</tr>
<tr>
<td>PPE</td>
<td>Personal Protective Equipment</td>
</tr>
<tr>
<td>GPS</td>
<td>Geographic Positioning System</td>
</tr>
<tr>
<td>RRQRR</td>
<td>Reverse Randomized Quadrant-Recursive Raster</td>
</tr>
<tr>
<td>GLONASS</td>
<td>Global Navigation Satellite System</td>
</tr>
<tr>
<td>OPUS</td>
<td>Online Positioning User Service</td>
</tr>
<tr>
<td>RINEX</td>
<td>Receiver Independent Exchange Format</td>
</tr>
</tbody>
</table>

2.4 Definitions

None given.
3 METHOD

Plot establishment is an essential step in the development of the NEON Terrestrial Observation System (TOS). Accurate and precise plot locations that represent the target ecosystem components at each site will facilitate reproducible data collection and spatial analysis for the life of the Observatory. All plot locations are created based on a spatially balanced random selection process (RRQRR), and individual plots are then accepted or rejected based on an assessment by field technicians (RD[15]). The RRQRR process results in a list of plots, each with a unique identifier called the Morton order. Following the Morton order list in ascending order (smallest to largest) within each plot type/NLCD class combination maintains the random selection process during plot establishment. This document outlines the procedures for location, evaluation, establishment, geospatial data collection and reporting for Tower Plots, Phenology Transects, Distributed Base Plots, Mammal Grids, Bird Grids, Tick Plots and Mosquito Point locations.

Tower Plots are located within or around the NEON tower airshed and will be sampled for above and belowground plant biomass and productivity, plant biodiversity, foliar and wood biogeochemistry, and soil biogeochemistry. Tower Plots will vary in size between and within sites depending on the dominant vegetation type and sampling methods. Low biomass, low stature vegetation such as that found in grasslands and homogeneous low diversity vegetation found in agricultural plots will be monitored in 400 m² square plots, measuring 20 meters on a side. Forested sites require larger plots to accurately measure plant biomass and productivity than sites dominated by herbaceous plants and shrubs. High biomass vegetation, found in forest will be measured in 1600m² square plots, 40 meters on a side. Plant phenology transects are also located within the NEON primary 90% flux tower airshed. Within each site there will be a subset of tower plots that require a hybrid approach because they contain additional measurements of biogeochemistry and plant diversity, this subset will be specified and directed by Science.

Distributed Plots will be located throughout the NEON site. Individual Distributed Plots may be accepted or rejected based on a field assessment by field technicians; potential plot locations are only accepted if the actual vegetation type is congruent with the assumed NLCD vegetation type. Prior to plot establishment, each plot has been subjected to an initial vegetation assessment. All sentinel taxa sampling will occur at Distributed Plots, although not all taxa will be measured at all Distributed Plots.

The Standard Operating Procedures in this document outlines the specifications for establishing each taxa-specific sampling plot. Site specific planning documents will identify the location of plots within the site, specify which taxa will be sampled at each of the identified plot locations and provide lists of contingency plot locations to replace rejected plots. This Standard Operating Procedure identifies plot establishment required for all current TOS plot types. The initial establishment includes plot acceptance, plot delineation, the collection of high resolution coordinates for each marker point, the assignment of Unique Identifiers and the placement of permanent plot markers with corresponding identifiers. Annual maintenance of established points may be necessary in the event markers are lost or
when markers are removed at the end of a sampling season due to site requirements. The annual marking of sampling points is achieved through the placement of temporary flagging or pin flags that may be removed following the final round of sampling for the field season.

Several high resolution coordinates will be taken at several locations within each established plot. In order to attain high accuracy (i.e. to within ≤ 30cm accuracy) at all points within each plot, a procedure has been developed. This procedure includes a detailed field planning phase, and field techniques that will assure the acquisition of the highest accuracy points given the tools available. The field planning will require the use of software (Trimble Pathfinder Office and Trimble Mission Planning packages) and a detailed GPS receiver accuracy setup. The field work will require attention to detail when following all procedures and the use of best practices. The post-field protocol constitutes a download of the data that will be post-processed by Science staff at headquarters (HQ).

3.1 NLCD Vegetation Classification

The NLCD is a continental scale land classification map. It spans the contiguous United States, as well as Hawaii, Puerto Rico and Alaska. The classification scheme is a two-tiered hierarchy, and our assessment focuses on the Level II categories (see NLCD Vegetation Classification Description). The most commonly used vegetation types are in bold.

Table 1. The NLCD land use and land cover classification system for use with remote sensing data.

<table>
<thead>
<tr>
<th>Level I</th>
<th>Level II</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Water</td>
<td>11 Open Water</td>
</tr>
<tr>
<td></td>
<td>12 Perennial Ice/Snow</td>
</tr>
<tr>
<td>2 Developed</td>
<td>21 Developed, Open Space</td>
</tr>
<tr>
<td></td>
<td>22 Developed, Low Intensity</td>
</tr>
<tr>
<td></td>
<td>23 Developed, Medium Intensity</td>
</tr>
<tr>
<td></td>
<td>24 Developed, High Intensity</td>
</tr>
<tr>
<td>3 Barren</td>
<td>31 Barren Land (Rock/Sand/Clay)</td>
</tr>
<tr>
<td>4 Forest</td>
<td>41 Deciduous Forest</td>
</tr>
<tr>
<td></td>
<td>42 Evergreen Forest</td>
</tr>
<tr>
<td></td>
<td>43 Mixed Forest</td>
</tr>
<tr>
<td>5 Shrubland</td>
<td>51 Dwarf Scrub*</td>
</tr>
<tr>
<td></td>
<td>52 Shrub/Scrub</td>
</tr>
<tr>
<td>7 Herbaceous</td>
<td>71 Grassland/Herbaceous</td>
</tr>
<tr>
<td></td>
<td>72 Sedge/Herbaceous*</td>
</tr>
<tr>
<td></td>
<td>73 Lichens*</td>
</tr>
<tr>
<td></td>
<td>74 Moss*</td>
</tr>
<tr>
<td>8 Planted/Cultivated</td>
<td>81 Pasture/Hay</td>
</tr>
<tr>
<td></td>
<td>82 Cultivated Crops</td>
</tr>
<tr>
<td>9 Wetlands</td>
<td>90 Woody Wetlands</td>
</tr>
<tr>
<td></td>
<td>95 Emergent Herbaceous Wetlands</td>
</tr>
</tbody>
</table>

*Alaska only
Definitions of each land cover type are available in Anderson’s land use and land cover classification systems (1976); also at [http://www.mrlc.gov/](http://www.mrlc.gov/).

Standard Operating Procedures (SOPs), in Section 7 of this document, provide detailed step-by-step directions, contingency plans, sampling tips, and best practices for implementing this sampling procedure. The value of NEON data hinges on consistent implementation of this protocol across all NEON domains, for the life of the project. To properly collect and process samples, field technicians must follow the protocol and associated SOPs. In the event that local conditions create uncertainty about carrying out these steps, it is critical that technicians document the problem and enter it in NEON’s problem tracking system. Use NEON’s problem reporting system to resolve any field issues associated with implementing this protocol.

Quality assurance will be performed on data collected via these procedures according to the NEON Science Performance QA/QC Plan (AD[05]).

Quality assurance procedures for plot establishment will be conducted by NEON Domain Field Operations staff and are an essential step in the establishment process. Correct placement and documentation of plot markers at each plot enable future field crews to locate and delineate plot boundaries precisely and identify which type of sampling activities to conduct at each location.

If errors originating in field establishment are detected in a future review, they may be very expensive to correct and will have a lasting effect on all sampling data associated with plot location. Field audits should be performed early in the initial field establishment process, to ensure problems are detected and corrected before an error is propagated across many plots. NEON will use a system of hot and cold checks similar to that described by the USFS Forest Inventory Analysis (FIA) program. The basic components of the FIA program are:

- **Hot checks:** Normally performed as part of the training procedure. Personal observation to ensure accurate carrying out of protocol by field technicians.
- **Cold checks:** An inspection done either as part of the training process, or as part of an ongoing QC program. Technicians are not present, and inspector does have access to field crew generated data at time of inspection.
4 SCHEDULE

4.1 Frequency and Timing

Except where placement of permanent plot markers is prohibited by site managers, initial plot establishment and collection of high resolution geospatial data will occur once per site. Annual establishment and re-marking of permanent plots for visibility may occur each year of operations prior to seasonal field sampling. Plot establishment must occur prior to scheduled taxa sampling.

4.2 Criteria for Determining Establishment Dates

Plot acceptance, delineation and marking should occur prior the start of first year of sampling. Annual plot establishment activities including re-marking of permanent plots should occur prior to seasonal field sampling.

4.3 Timing for Laboratory Processing and Analysis

This protocol generates no samples for laboratory analysis.

4.4 Sampling Timing Contingencies

Plot establishment should be completed prior to Operational sampling. Interruptions or delays in the process—either during a specific plot or all plots—do not impact NEON data products as long as plots are in place to facilitate the accurate and repeatable observations of Operational sampling.

Reasons to delay sampling have to do with the optimization of establishing a precise, accurate plot with good geographic record (GPS collection). Reasons to alter the timing of sampling include:

- Precipitation (rain or snow) that interferes with rangefinder
- Dense canopy cover that reduces the satellite reception
- Periods of the day when satellites are less accessible
- Challenges with host site allowing the process to complete, i.e. access issues or other problems with completing the process

Table 2. Contingent decisions

<table>
<thead>
<tr>
<th>Delay/Situation</th>
<th>Action</th>
<th>Outcome for Data Products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precipitation or snow</td>
<td>Stop rangefinding work</td>
<td>No impact on data products as long as plots are established prior to sampling</td>
</tr>
<tr>
<td>Insufficient satellite reception</td>
<td>Spend more time at each point, optimize time of day, or wait until leaf-off</td>
<td>No impact on data products as long as plots are established prior to sampling</td>
</tr>
</tbody>
</table>

5 SAFETY

This document identifies procedure-specific safety hazards and associated safety requirements. It does not describe general safety practices or site-specific safety practices.

Personnel working at a NEON site must be compliant with safe field work practices as outlined in the Operations Field Safety and Security Plan (AD[02]) and EHSS Policy, Program and Management Plan (AD[01]). Additional safety issues associated with this field procedure are outlined below. The Field Operations Manager and the Lead Field Technician have primary authority to stop work activities based on unsafe field conditions; however, all employees have the responsibility and right to stop their work in unsafe conditions.

A post driver and/or sledge hammer is used to drive the plot monuments into the ground. Safety considerations for this equipment include:

- Inspecting and wearing appropriate personal protective equipment (PPE). This may include impact gloves, hearing protection, and safety glasses.
- Maintaining appropriate posture while driving the monuments, including keeping the back straight, having a stance square to the monument, and maintaining a safe working height (e.g. working downhill of the monument and/or kneeling when appropriate).
- Using an appropriate driving technique to maintain control of the equipment, prevents missed swings, and minimizes the potential for injury.
- Using a Survey Monument Post Driver (30 inches or longer).

A hand or power saw is occasionally used to cut off a portion of the monument rod. Safety considerations for this equipment include:

- Inspecting and wearing appropriate PPE. This may include cut-resistant gloves, hearing protection, and safety glasses.
- Operating the equipment with a blade of the appropriate style and in good condition.
- Using an appropriate cutting technique to maintain control of the saw and minimizes the potential for injury.
### 6 PERSONNEL AND EQUIPMENT

#### 6.1 Equipment

The following equipment is needed to implement the procedures in this document. Equipment lists are organized by task. They do not include standard field and laboratory supplies such as charging stations, first aid kits, drying ovens, ultra-low refrigerators, etc.

Table 3. Equipment list – A crew of two technicians preparing for establishment of one plot

<table>
<thead>
<tr>
<th>Item No.</th>
<th>R/S</th>
<th>Description</th>
<th>Purpose</th>
<th>Quantity</th>
<th>Special Handling</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Durable items</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MX102549</td>
<td>R</td>
<td>GPS receiver, decimeter accuracy (e.g. GEO XH 6000, 7X)</td>
<td>Loading data to GPS that will locate plots and generate spatial locations of plot points</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX100322</td>
<td>R</td>
<td>Laser Rangefinder</td>
<td>Laying out the plot in proper dimension</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>GPS Pathfinder Office Software NEON</td>
<td>Loading data to GPS that will locate plots and generate spatial locations of plot points</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>Marker cutting equipment</td>
<td>Cutting secondary markers</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Consumable items</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>Secondary markers (e.g. PVC pipe)</td>
<td>Raw material for secondary markers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>Additional materials to label markers (e.g. spray paint)</td>
<td>Label flags, PVC and/or other secondary markers</td>
<td>1</td>
<td>N</td>
</tr>
</tbody>
</table>

R/S=Required/Suggested
Table 4. Equipment list – A crew of two technicians performing field establishment of one plot

<table>
<thead>
<tr>
<th>Item No.</th>
<th>R/S</th>
<th>Description</th>
<th>Purpose</th>
<th>Quantity</th>
<th>Special Handling</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX102549</td>
<td>R</td>
<td>GPS receiver, decimeter accuracy (GEO XH 6000, 7000)</td>
<td>Locate plots and generate spatial locations of plot points</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>Extra battery for GPS receiver</td>
<td>Extend field GPS collection time</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX105014</td>
<td>R</td>
<td>Range Pole Bracket</td>
<td>Secure range pole to GPS</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX105015</td>
<td>R</td>
<td>Range pole with bi-pod attachment</td>
<td>Hold antenna</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX105009</td>
<td>R</td>
<td>Antenna</td>
<td>Receive satellite information</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX105012</td>
<td>R</td>
<td>Antenna Cable</td>
<td>Connect antenna to GPS</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX100322</td>
<td>R</td>
<td>Laser Rangefinder, ½ foot accuracy</td>
<td>Lay out the plot in proper dimension</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>Extra batteries for Laser Rangefinder</td>
<td>Extend field time of rangefinder</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>Lens cleaning cloth</td>
<td>Cleaning rangefinder lens</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>Reflective tape or bicycle reflector</td>
<td>Sight rangefinder</td>
<td>2</td>
<td>N</td>
</tr>
<tr>
<td>MX100320</td>
<td>R</td>
<td>Compass with mirror and declination adjustment</td>
<td>Sight angles for laying out the plot</td>
<td>2</td>
<td>N</td>
</tr>
<tr>
<td>MX100722</td>
<td>R</td>
<td>Measuring tapes ≥30 m</td>
<td>Measure distances for laying out the plot</td>
<td>2</td>
<td>N</td>
</tr>
<tr>
<td>MX104361</td>
<td>R</td>
<td>Chaining pins or other suitable anchor</td>
<td>Anchor measuring tapes</td>
<td>5</td>
<td>N</td>
</tr>
<tr>
<td>Item No.</td>
<td>R/S</td>
<td>Description</td>
<td>Purpose</td>
<td>Quantity</td>
<td>Special Handling</td>
</tr>
<tr>
<td>----------</td>
<td>-----</td>
<td>-------------</td>
<td>---------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Maps</td>
<td>Navigation to plot</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Log Sheets (See Appendix A)</td>
<td>Record information/notes</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Definitions of Land Use and Land Cover Classification</td>
<td>Field-based validation</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>FOPs datasheet with a list of potential plots</td>
<td>Reference</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>GPS receiver, recreational accuracy with fully charged batteries</td>
<td>Navigation</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>GPS Pathfinder Office Software</td>
<td>Transfer and inspect spatial data</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>Anchor</td>
<td>Plot delineation</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>PVC pipe cutter</td>
<td>Cutting secondary markers</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX110476</td>
<td>R</td>
<td>Survey Monument Post Driver (30 inches or longer)</td>
<td>Install primary markers</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Survey Monument Driving Pin Adapter</td>
<td>Install primary markers</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>MX110497</td>
<td>R</td>
<td>Impact gloves</td>
<td>Protect Hands from the potential force of the driver striking the post.</td>
<td>1 pair per staff</td>
<td>N</td>
</tr>
<tr>
<td>MX110498</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MX110499</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MX110500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item No.</td>
<td>R/S</td>
<td>Description</td>
<td>Purpose</td>
<td>Quantity</td>
<td>Special Handling</td>
</tr>
<tr>
<td>-------------</td>
<td>-----</td>
<td>-------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td>MX104257</td>
<td>R</td>
<td>Ear Plugs</td>
<td>Protect ears and hearing from loud noises while driving monument rods</td>
<td>1 pair per staff</td>
<td>N</td>
</tr>
<tr>
<td>Or MX102814</td>
<td>R</td>
<td></td>
<td>into the ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(latex free)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MX104378</td>
<td>R</td>
<td>Sledge hammer</td>
<td>Driving monument rods</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX107089</td>
<td>R</td>
<td>4.5”x0.75” stainless steel driving adapter</td>
<td>Driving monument rods</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>e.g. MX101703</td>
<td>R</td>
<td>Hand or power saw</td>
<td>Removal of excess rod</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>e.g. MX101535</td>
<td>R</td>
<td>Pliers</td>
<td>Tightening sections</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>MX109524</td>
<td>S</td>
<td>Crow or pry bar</td>
<td>Removal of temporary plot marker</td>
<td>1</td>
<td>N</td>
</tr>
</tbody>
</table>

**Consumable Items**

<table>
<thead>
<tr>
<th>R</th>
<th>Pin Flags, PVC posts or other temporary markers¹</th>
<th>Used during plot delineation</th>
<th>Max 20 per plot</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Secondary Markers (e.g. PVC, Survey stakes)¹</td>
<td>Marking plot corners</td>
<td>variable</td>
<td>N</td>
</tr>
<tr>
<td>MX107388</td>
<td>2.5” flat survey cap, stamped</td>
<td>Monument component</td>
<td>variable</td>
<td>N</td>
</tr>
<tr>
<td>MX106864</td>
<td>1’x0.75” aluminum monument rod sections</td>
<td>Monument component</td>
<td>variable</td>
<td>N</td>
</tr>
<tr>
<td>MX106865</td>
<td>3’x0.75” aluminum monument rod sections</td>
<td>Monument component</td>
<td>variable</td>
<td>N</td>
</tr>
<tr>
<td>Item No.</td>
<td>R/S</td>
<td>Description</td>
<td>Purpose</td>
<td>Quantity</td>
</tr>
<tr>
<td>------------</td>
<td>-----</td>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>MX106994</td>
<td>R</td>
<td>3’x0.75” aluminum monument rod sections</td>
<td>Monument component</td>
<td>variable</td>
</tr>
<tr>
<td>MX106863</td>
<td>R</td>
<td>6”x0.75” aluminum driving rod section</td>
<td>Monument component</td>
<td>variable</td>
</tr>
<tr>
<td>e.g. MX101705</td>
<td>R</td>
<td>Metal blades for hand or power saw</td>
<td>Removal of excess rod</td>
<td>1</td>
</tr>
<tr>
<td>R</td>
<td>R</td>
<td>Paper plate</td>
<td>Catchment for saw debris</td>
<td>1</td>
</tr>
<tr>
<td>S</td>
<td>S</td>
<td>Additional materials to label markers (e.g. spray paint)</td>
<td>Label flags, PVC and/or other secondary markers</td>
<td>2</td>
</tr>
<tr>
<td>S</td>
<td>S</td>
<td>Pencils</td>
<td>Record information/notes</td>
<td>3</td>
</tr>
<tr>
<td>S</td>
<td>S</td>
<td>Additional materials to label markers (e.g. spray paint)</td>
<td>Label flags, PVC and/or other secondary markers</td>
<td>1</td>
</tr>
</tbody>
</table>

R/S=Required/Suggested

1 Secondary and temporary marker quantities will vary depending on plot type and site-specific plot monumentation strategies, which will be dependent upon local conditions and site host restrictions.
6.2 Training Requirements

All technicians must complete required safety training and protocol-specific training for safety and implementation of this protocol as required in the Field Operations Job Instruction Training Plan (AD[04]).

All field technicians must have hands-on training with the GPS receiver with TerraSync software, antennae, laser rangefinder and handheld compass with sighting mirror and declination prior to conducting field work. At least two technicians in each domain shall be trained and proficient in the use of GPS Pathfinder Office software and mission planning.

6.3 Specialized Skills

A team of two field technicians is required for plot establishment (delineation, marking and spatial data collection). Training will be provided for all specialized skills required for carrying out plot establishment (i.e. equipment use). Technicians are not required to have any additional skills other than those specified in the NEON Field Technician job description. Proficiency with compass and GPS receiver is useful and should be part of training to prepare to go into the field for this protocol.

6.4 Estimated Time

The time required to implement a protocol will vary greatly depending on a number of factors, such as skill level, system diversity, environmental conditions, and distance between sample plots. The timeframe provided below is an estimate based on completion of a task by a skilled two-person team (i.e., not the time it takes at the beginning of the field season). Use this estimate as framework for assessing progress. If a task is taking significantly longer than the estimated time, a problem ticket should be submitted.

A two person team will require approximately four hours to establish one distributed base plot. Plot establishment includes metadata collection, plot delineation, marking, and spatial data collection.
7 STANDARD OPERATING PROCEDURES FOR TOS PLOTS

Figure 1. Generalized site-scale sampling schematic for the NEON Terrestrial Observation System (TOS)
7.1 Workflow of Plot Establishment Activities

- Compile all Equipment and Materials *SOP A*
- Navigate to preloaded point *SOP B*
  - Complete NLCD canopy cover assessment
  - Does the vegetation at the plot match the expected vegetation class? *SOP B* Complete logistical validation.
  - NO
  - Create a New Data File
  - Reject plot location, note the reason, choose next plot from RRQRR list. *SOP B*
  - Distributed
    - Perform Distributed plot Delineation and Monumentation for:
      - Base, Small Mammals, Birds or Ticks. *SOP C*
  - Conduct GPS Coordinate Collection. *SOP D*
  - Check for co-located plots. Pull flags and tape, navigate to next preloaded potential plot origin.
  - At the end of day complete *SOP E* to transfer data
  - YES
    - Create a New Data File
    - Record metadata in data dictionary *SOP B*
    - Is the plot a tower or distributed plot?
      - Tower
        - Perform Tower plot Delineation and Monumentation for:
          - Plant Productivity or Phenology. *SOP C*
SOP A Preparing for Establishment

A.1 Resources

During training you will be provided with a NEON network drive path. This drive will serve as a communication gateway between Science and FOPS; it will also serve as a source of materials for data collection. The corresponding drive will include the following materials:

Table 5. Materials provided for use of FOPs and Science. These folders are located in the designated drive; the specific organization of these folders is not outlined in this table.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Content</th>
<th>Format</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS_Pathfinder_Files</td>
<td>Contains all GPS data files (plot locations, roads, boundary and others) used by FOPS for collection.</td>
<td>.imp</td>
<td>Data files to be used by FOPS staff to collect plot data.</td>
</tr>
<tr>
<td>Site_Information_&amp;_Datasheets</td>
<td>Maps</td>
<td>.pdf</td>
<td>Maps to be used by FOPS.</td>
</tr>
<tr>
<td></td>
<td>Plot layout and site information</td>
<td>.kmz</td>
<td>Layers to be used in google earth by FOPS</td>
</tr>
<tr>
<td></td>
<td>XX_XXXX_TOS_Plots_Datasheet: Contains all Distributed plots, Morton Order, vegetation type, plot status and coordinates.</td>
<td>.xlsx</td>
<td>Datasheet to be used by Science and FOPS, must be regularly updated by FOPS.</td>
</tr>
<tr>
<td></td>
<td>Contains site information and notes from previous remote and field (if applicable) validation</td>
<td>.docx</td>
<td>Background information about the site for FOPs</td>
</tr>
<tr>
<td>Established</td>
<td>XX_XXXX_Unique_Identifiers: Contains plot type, Morton Order and PlotID.</td>
<td>.xlsx</td>
<td>This datasheet contains all PlotIDs used to label TOS plots. Datasheet created by Science and used by FOPS.</td>
</tr>
</tbody>
</table>
## Purpose

Unique Identifiers should be provided by Science after plots are established, to be used for plot marker labels.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Content</th>
<th>Format</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data_Dictionaries</td>
<td>XX_XXXX_Validation_Information: Contains all data dictionaries. A Data dictionary is a digital form used to log metadata about each plot. Data Dictionaries are uploaded to the GPS receiver.</td>
<td>.ddf</td>
<td>To be used by FOPS to collect ALL plot establishment data.</td>
</tr>
<tr>
<td>Log_Sheets</td>
<td>Contains log sheets used to maintain a record of markers and GPS data collection.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A.2 GPS Receiver Setup

The following are the general steps to follow in order to complete the GPS setup. To complete this section please follow the detailed steps in GPS Receiver Setup. Newer versions of the GEO and/or Terra Sync might have slightly different layouts. See the specific technical manual for the relevant GPS model and software version. Contact Science if you need additional help.

1. Turn GPS receiver on.
2. Initialize GPS software (i.e., Terra Sync).
3. Once the GPS software is initiated, on the first day of work at a site make sure to adjust the GPS time, specifically the GPS unit Time Zone, Date and Time.
A.3 Global Navigation Satellite System (GNSS) Planning Online software

The GNSS Planning online software tool will help you understand satellite availability (number of satellites) before heading out to the field. If the site at hand has little satellite cover (fewer than six satellites at a time), it is important to find the windows of time with higher satellite availability. Use these windows of time to collect high-accuracy data. If the site has a constant flow of six or more satellites at a time, then the time of collection is less important. To find out satellite availability and to plan your field days -as needed-, use the following steps:

2. Click on the Setting tab located in the upper left side of the window.
   a. To assess the relative satellite availability across a site, add the latitude and longitude of the tower location (RD[20]).
   b. Height : 0 m
   c. Cutoff: change it to 0°—however, this field can be changed if obstructions are known at a particular plot. For this the latitude and longitude must be related to a particular plot.
   d. Select the field Day
   e. Select the starting time or Visible Interval and the time span in hours (generally a 6- or 12-hour span).
   f. Select the appropriate Time Zone.
   g. Click Apply.
3. To the left of the screen click on the Satellite Library
   a. Click on the GPS and the GLONASS satellite libraries; unclick the rest of the satellite libraries.
4. To the left of the screen click on the Number of Satellites.

This histogram will display the number of satellites (GPS and GLONASS) available on the Y axis, and time on the x axis, including what the GPS would measure with any obstructions previously plugged in the Settings (if any). The higher the number of satellites available the better the accuracy will be. This graph will allow field workers to know when the best times to establish challenging plots may or may not be.

**In your notes**, record what times have the highest number of satellites (highest accuracy) and what times have the lowest number of satellites (lower accuracy) to collect GPS data. Avoid accruing data in the times when there are fewer than four satellites available; otherwise the data will be of low accuracy.
A.4 GPS Pathfinder Office

Types of files to transfer for a typical fieldwork campaign:

The data files to transfer for a typical fieldwork campaign will be located in a shared folder in the N/Science/GISdata/FOPS (see Table 5) drive. These files will be in .imp format (these are Trimble imported files that can be read by both Pathfinder Office and the GPS unit). There are three types of files that will be transferred from Pathfinder Office to the GPS unit:

a. **Background files** include roads, lakes, streams, buildings, contours and others. These files are located in folder GPS_Pathfinder_Files, see Table 5.

b. **Data files** includes points converted from ArcGIS shape files. These are the points that will be followed and have been previously assessed for plot establishment. These files are located in folder GPS_Pathfinder_Files, see Table 5.

c. **GPS Data dictionary** contains pre-defined attributes and metadata that can be associated with newly logged GPS data. The GPS data dictionary will be completed for every point collected. These files are located in folder Data_Dictionaries, see Table 5.

Loading and checking files in GPS with Pathfinder Office

1. **Open** Pathfinder Office software
2. **Create a project** for each site. Set up the Default folders in the shared folders provided

![Figure 2. Pathfinder Office project](image)

3. **Go to Options and select Coordinate System**
   a. Select by: **click on Coordinate System and Zone** select the appropriate system, zone and datum
   b. **Altitude Measured From:** select Mean Sea Level (MSL)
   c. **Coordinate units:** Meters
   d. **Altitude Units:** Meters
4. In the main screen, select **File > Background…** and in the “Load Background Files” window, click “Add…” and select the file(s) desired as background images (e.g. boundary, roads, streams).

5. Check the box next to the desired image(s).

6. Click **OK** to load the background files into the Map.

7. Click **View > Map** to visually check the images that will be loaded to the GPS.

8. To check data files open the imp, .ssf, .cor, or .imp file in Pathfinder by selecting **File > Open** or dragging the file into the map.

9. In the main screen select **Data > Feature Properties** and select **Data > Position Properties**.

10. Click on the X’s in the map view (the individual points) to load the point information in the Feature Properties and Position Properties boxes.

a. For example, you can view the date, number of logs, estimated accuracy, and point feature name of a point in an .ssf, .cor, .imp file.
A.5  Transfer data files, GPS data dictionary, and background image(s) to the GPS unit

There are two methods to transfer files to and from the Trimble unit; using a SD media card and connecting directly to the computer through a cable. Due to frequent updates, the cable method instructions are updated in service now and links can be found in the sampling support library.

SD media card method:

1. Insert the SD card into the computer
2. Open GPS Pathfinder
3. Open the “Data transfer” tool by clicking the computer-to-unit icon button

4. Click the “Devices: button to select the device/folder the files will be transferred to
   a. If it is a new SD card, select “New”.
      i. Create a “GIS Folder” in the pop-up and click “OK”
   b. If the SD card is not new click “Browse”
      i. Find the device, click “Next”
   c. Specify the type of files as “TerraSync”.
   d. Specify the version as “v3xx, v4xx, v5xx”. Click “Next”
e. Name the Device i.e. “Trimble SD 2”. Click “Finish”.

f. Highlight the Device and click close

5. Ensure the Device is connected by clicking the connector cord with the green check mark.

6. Select the “Send” tab. Click “Add” to find the device (SD card).
a. Select “Data File”
7. Navigate to the folder with the .imp files
   a. Select one or many .imp files
8. Click “Transfer All” to transfer the data to the SD card
9. A pop-up window will appear. Once complete click “Close”
10. Eject the SD card from the computer
11. Turn on the Trimble and open Terra Sync
12. Insert the SD Card into the slot on the right side of the Trimble. The port is covered by a rubber flap, labeled “SD”.
13. Using the MDD, select “Data”
14. Use the SDD menu, select “Existing”

15. Under the drop down menu for Location, select “Storage Card” (“Default” will be selected upon opening the Data>Existing page)
16. At least one satellite must be connected to the Trimble unit to open the data files.

A.6 Configure the rangefinder

Refer to RD[19] for details.
A.7 Site Specific Plot Information

An excel sheet will be provided for each site by science staff in a shared folder (Table 5 in folder “Site_Information_&_Datasheet”). The sheet contains information regarding the morton order list, plot type, plot size, plot location, number of target plots per NLCD vegetation type, and spaces for field technicians to update progress. The sheet will be the main point of contact between FOPs and Science during plot establishment. PDF maps and kmz files for google earth will be provided as well.
SOP B  Plot Acceptance

At the start of the field day, remember to:

- ** ✓** Turn on the unit in an open area for at least 5 min before entering a closed canopy system.
- ** ✓** On a daily basis, verify that the GPS almanac has been updated within the last week or anytime the unit is moved to a new NEON site. To update the almanac it is necessary to have at least one satellite locked and it should take at most 15 minutes. To check when the almanac was last updated go to MDD>Status and SDD>Receiver>Almanac
  - To force an almanac update go to MDD>Setup and SDD>Options>Reset GNSS Receiver
- ** ✓** Once the GPS has been turned on, take care to always keep the antenna relatively flat, even when not collecting data. This will ensure that a minimum number of satellites are dropped.
- ** ✓** Do not stand in front of or otherwise block GPS unit. Make sure the barometric pressure holes on the under-side of the Trimble are not obstructed.
- ** ✓** While hiking or collecting data, make sure the sleep function is disabled, every time the unit goes into sleep mode satellites will be lost. To disable the sleep function:
  - Press the green button for 3 seconds. This button is located below the screen
  - Click on **Power Settings**
  - Uncheck the box below **On battery power**
  - Click **OK**
- ** ✓** Always take an extra fully charged GPS battery.
- ** ✓** Create a Waypoint for the location of the vehicle:
  1. Click on MDD > **Navigation**
  2. On the SDD > **Waypoints**
  3. Click on **New** at the lower left side of the screen.
  4. Location **Default**
  5. Name waypoint at **File Name**
  6. Click **Done**
  7. Click on **Options** on the upper right, and then click on **New**.
  8. Name the waypoint (i.e. RMNP_Car_06162011)
  9. Click on **Create Form** on the upper right, and then click on GNSS. The coordinates should load.
  10. Click **Done**. Waypoint should be created.
  11. To close the created file, go to **Options** and click on **Close File**.
  12. Go back to MDD > **Navigation**. Make sure the SDD is on Waypoint and then Click **OK**. The waypoint should be created.
  13. When returning to the car, click on MDD > **Navigation** and SDD > **Waypoints**. Highlight the file of interest and click **Open** on the lower right side of the screen.
  14. Click on the box to active and tap for one second on the waypoint files. Click on **Set Nav Target**
15. Go back to SDD> Navigate and when moving it will point you to the navigation target.

B.1 Navigate to pre-loaded GPS point

Preloaded GPS points will be classified by plot type (See Method section for a list of plot types). Before leaving the car create a waypoint of the car location or starting location AND write down the coordinates and elevation of the car in a field notebook, this is a safety practice to ensure technicians have coordinates to navigate back to the vehicle.

1. **Open** the data file associated with the current site:
   a. Go to MDD > Data, and then go to the SDD > Existing File. You should see a list of data files loaded onto the Trimble.
   b. Select the data file associated with the current site, and click **Open**.
   
   - Make sure that the Antenna Height is at 1 m, and the Type refers to the GPS internal model. Keep the setting on “measure to bottom of receiver”; then click **OK** on “confirm antenna height” pop-up.
   c. Go to MDD > Map to see the plots loaded on the map. Go back to MDD > Data.
   d. Find the Plot Morton Order of the targeted plot. Tap and press (1-2 seconds) on the Morton Order number. A pop-up menu should appear. Select Set Nav Target. Note: the targeted plot should now have a flagged symbol.

   Or

   To set a plot as a navigation target from the MDD > Map, choose the Select tool (➚) from the left-most SDD, and hold the stylus on the plot until a box pops up that says “Delete” and “Set Target.” Choose “Set Target.”

   To check the Morton order of a plot from the Map pane, tap on the select tool from the left-most SDD menu. Tapping a plot icon quickly with the stylus will bring up the name and coordinates of that particular plot.

2. To zoom in, while in the MDD>Map, go to the leftmost SDD menu and select the zoom-in tool. Zoom in by dragging the stylus along a diagonal that encompasses the desired area.

3. Go to MDD > Navigation and make sure the left SDD says Navigate.

   For some Trimble models with no internal compass, the Navigate window won’t make any sense until you are moving. If navigating over longer distances it is often easier to take the bearing from the GPS unit and then navigate with a regular compass until you within ~20m of the point.

   e. When close to the target position the location of the GPS is displayed as an “X” and the target as an “O”. You will need to move around until you are as close as possible to the
desired location ("O"). Make sure you are within 3 meters from the desired location. If you are having trouble obtaining the desired location within 3 meters, attach the antenna following the instructions in SOP D.

f. When you have arrived at a targeted point, go to MDD > Map, and select Options > Clear Nav Targets. Go to MDD > Data and click on Done and then on Close button to exit the points data file. A window will pop up asking: Close this file. Are you sure? Click on Yes.

If the unit goes into sleep mode, push the power button again to wake the unit and resume data collection. Make sure to wait until satellites are re-acquired. A warning will pop up; click Dismiss. If the GPS unit is not collecting satellites, go to MDD > Setup and click the GPS button again to reconnect the GPS receiver. Then return to the Map screen and resume data collection.

B.2 Canopy cover assessment

Canopy cover assessment will be based on the National Land Cover Database (NLCD) classification (Appendix E) for all Distributed Plots. Plot locations are only accepted if the actual vegetation type is congruent with the assumed NLCD vegetation type. The XX_XXXX_TOS_Plots_Datasheets provided by Science lists the NLCD land cover type in the “nlcdClass” column (see Table 5).

1. Once within the plot, determine location of plot perimeter, you can run a tape across four cardinal directions (or use the range finder and reflector) and set up visual cues (it could be flagging tape, a rock, a tree etc.) that would indicate the perimeter of the plot.
   a. Since Bird and Mammal Grids are so large and it is difficult to determine land cover type percentages err on the side of NLCD unless the classification is obviously off.
   b. For Mosquito Points validate an area 40m by 40m with the point location as the centroid.

2. Determine plot Level 1 classification (e.g. Forest, Shrubland). Located in NLCD classification description (see Appendix E).
   a. Remember- NLCD defines the dominant vegetation stratum by height (i.e. the tallest vegetation is “dominant”) since NLCD assesses canopy from satellite imagery.

3. Within each Level 1 NLCD class, determine Level 2. For example, if the Level 1 classification is Forest, the next step is to determine if it is a Deciduous, Evergreen, or Mixed Forest.

   IMPORTANT: Level 1 classification determines the total percent cover for the plot (e.g. 40% of the plot is forest); Level 2 is then assessed out of 100% of the Level 1 total (e.g. of the 40% of the plot that is forest, 50% of that forest area is deciduous, 50% of that forest area is evergreen, NOT 20% deciduous forest and 20% evergreen forest).

4. Evaluate the results of the Level 1 and Level 2 classification to determine whether the plot should be accepted or rejected.
In instances where the plot classification (either Level 1 or Level 2) is unclear due to borderline percent cover(s) (i.e. near the % cover cut-off described in E), acceptance or rejection should be based on group consensus. If disagreement persists, the plot should be rejected. For example, when validating a deciduous forest plot (Level 2) where more than 75% of the total forest cover in the plot should be deciduous to be accepted, if the sampling crew cannot agree because person 1 thinks plot deciduous forest cover is below the 75% threshold and person 2 thinks the plot is above this threshold, then the plot should be rejected.

If level 1 classification is rejected, please assess both Level 1 and Level 2 classifications and record to the corresponding rejected plot metadata.

5. Begin metadata collection with the Trimble, regardless of the results of the above assessment, as described in SOP sections B.3 through B.7.
   a. If plot is accepted based on above assessment, place a temporary marker (anchor, flag, etc.) in the center of the plot.
B.3 Trimble Data File Naming Conventions

Files must be named according to the following convention:

Filename begins with the letter D, followed by the two digit number for the domain, followed by an underscore: e.g. D01_

1. Add the four letter site ID followed by an underscore: e.g. D01_HARV_
2. Add the value denoting Morton Order plot number followed by an underscore: e.g. D01_HARV_1__, D01_HARV_1234020_
3. Add a letter to indicate the plot type followed by an underscore: e.g. D01_HARV_1__T_. Plot type letters are:
   - “T” to indicate a “Tower” Plot.
   - “H” to indicate a “Phenology” Plot.
   - “R” to indicate a “Distibuted Base” Plot.
   - “K” to indicate a “Tick” Plot.
   - “M” to indicate a “Mammal” Grid.
   - “B” to indicate a “Bird” Grid.
   - “Q” to indicate a “Mosquito” Point.

4. If the plot is accepted the letters “GPS” are added to indicate file contains GPS data: e.g. D01_HARV_1__T_GPS

Each time a plot is visited to collect GPS points a new file must be created. Follow the same naming convention outlined above and add V # to the end of the file name. E.g. D01_BART_199_R_GPS_V4 if it is your fourth time collecting GPS points at a plot.
B.4 Metadata collection

Metadata collected with the GPS includes information about plot acceptance, vegetation type, and other plot characteristics. Use the appropriate GPS data dictionary and plot ID labeling (Section B.3). Metadata only needs to be collected once per plot.

To collect metadata use the following instructions:

a. Make sure the file used to hike to the plot has been Closed; if it hasn’t, go to the MDD > Data and click Done.

b. When establishing plots, create a new data file for each unique plot. Go to MDD > Data, and then go to the SDD menu and select New (T).

c. Keep the settings on File type (Rover) and Location (Default); Click on the File Name field and choose an appropriate name. Refer to the ‘Data File Naming Guidelines’ (B.3) of this protocol for naming convention.

1) Note: If you are using a SD card to transfer files then change the Location to “Storage Card”. This specification can be changed after the file is collected as well if necessary.

d. In Dictionary Name choose the GPS data dictionary that is appropriate for the given plot (Distributed Base Plot, Tower Base Plot, Mammal Grid, etc) and task (soil sampling at 20m by 20m Tower Base Plots, Plant Diversity sampling at 40m by 40m Tower Base Plots, etc). Click Create.

e. Change antennae height to 2.000 m

f. Select Type as antenna model 2 and click OK (Do not set up the antenna at this point).

g. Open the appropriate GPS data dictionary based on the plot type you are currently in. Make sure the receiver is active by going to the MDD>Setup; if the satellite icon is not visible: click on the GNSS box which should be in upper right side of the screen, if the receiver is NOT active you will see a satellite icon to the right of the MDD menu. If the receiver is already active the following message should appear:

Are you sure you want to disconnect from GNSS receiver? Click on NO to maintain the receiver active

All GPS data dictionaries will contain a set of features; you will need to go through all of them.

h. Go back to the MDD>Data screen; once the new file is created open the metadata feature. The following includes all fields across GPS data dictionaries reflected in the metadata feature. All or a subset of these questions will be in the corresponding GPS data dictionary:
• **Date**: Click on the drop down menu and choose the corresponding date.

• **Operator Name**: click on the blank space below and the keyboard should appear, write down the initials of the two crew members.

• **Morton Order**: on the list of plots find the corresponding plot Morton Order number and record it.

• **NLCD Vegetation**: click on the drop down menu and select the vegetation subclass information that has been predetermined by NLCD and vetted by remote sensing validation specialists.

• **Site Vegetation**: after a team analysis of the canopy percent cover, determine the existing vegetation NLCD category

• **Percent Cover**: NLCD Percent Cover: i.e. 55 deciduous forest 45 evergreen forests.
  - Make sure that the sum of the percentages add to 100%. Account for the highest strata only (i.e. if there is an evergreen, deciduous upper canopy and a shrub lower canopy, only account for the higher stratum for your percent cover—see section B.2).

• **Plot Accepted**: if the NLCD vegetation is the same as your team’s assessment of the site vegetation then click on **YES** to accept the plot, otherwise select **NO**. If rejecting the plot based on criteria other than NLCD mismatch (see section B.5), also select **NO**. When No is selected, several fields will recede from view, at this point click Done and close the feature.

• **Tree Cover**: assess % cover based on bird’s eye view, select from the drop down.

• **Saplings and shrubs cover**: assess % cover based on bird’s eye view, select from the drop down. For example, if the entire understory of a plot is shrubs but 50% of the plot is covered by tree cover than the sapling and shrubs cover will be 50%.

• **Herbaceous cover**: assess % cover based on bird’s eye view, select from the drop down.

• **Slope**: standing at the centroid, select the steepest slope to any of the following point IDs: 49, 50, 51, 40, 42, 31, 32, 33. Use the rangefinder RD[19] to measure the slope (percent).
  - If the steepest slope point does not have a line of sight, choose the next location that has a line of sight and is the closest to the steepest slope
  - If there isn’t a line of sight to any of the point IDs targeted, find a line of sight that brings you the closest to any of the previously mentioned point IDs; for example, a line of sight between the centroid and 5 meters towards point ID 32.

• **Slope Azimuth**: this is the azimuth of the slope inclination previously made, use rangefinder, RD[19].
  - With Rangefinder still at low end of slope and reflector at the high end, change measurement mode to **AZ**.
  - Measure azimuth (degrees)
- If the slope is 0 the azimuth is not required.

- **Comments**: add any pertinent comments, for example ‘plot has several fallen tree trunks.’ If there are potential obstructions that can affect GPS measurements make note of azimuth and description of obstruction object.

  i. Click **Done** to store data. Close the feature but **NOT** the file. A message should appear: “No positions recorded. Do you want to store this feature now?” click **Yes**. If the data file is accidentally closed follow instructions **below**.

**How to Access an Existing Closed Data File**

1. Go to MDD>Data and SDD>Existing files
2. Look for the desired existing file
3. Click on the file
4. Click Open on the lower left of the screen
B.5  Rejected sampling plots

In all cases where a plot is rejected, record the rationale in the corresponding pre-loaded Data Dictionary. Do not record spatial location for rejected plots. After recording metadata, move on to the next plot location in sequence based on the Morton Order plot list. If the rejection of plots is so high that it is not possible to establish the desired number of plots at a given site, contact Science to provide additional plot locations.

A selected plot may be rejected by the field crew if:

- Plot location is in a creek (wider than 10m), is too wet (see Appendix C), or presents other geographical features that prevent sampling as specified in the associated TOS protocol(s).
- The Distributed Plot conditions do not match the NLCD vegetation classification. Note that NLCD vegetation does not apply to Tower Plots or Phenology Plots.
- Field conditions are deemed unsafe by the field crew.
- Logistical reasons as determined by Field Operations staff; make sure the reasoning is outlined in the comments field of the plot’s metadata.
- Tick plots may be rejected if more than 50% the plot perimeter (i.e., 80m of the 160m perimeter) is not amenable for tick sampling using the dragging or flagging method(s) (or both). For example, sections of the perimeter that run through dense patches of briars likely cannot be sampled by either method.
- If a 4m offset is not enough to negotiate around an obstacle at the centroid of a base plot. See section B.7 for more information on offsets.

To record rejected plots follow these steps:

1. Make sure the file used to hike to the plot has been Closed; if it hasn’t go to the MDD > Data and click Done.
2. Follow the naming convention in section B.3 and the steps in B.4 to create a file and fill out the metadata.
3. Keep Type as the internal antenna option for your model and click OK, this will set the unit for hiking.
4. Answer all relevant questions in the GPS metadata feature (SOP B.4). Once metadata are completed, close feature.
5. Close data file; a message will appear: No positions recorded. Do you want to store this feature now? Tap on Yes
7. And select next location following the Morton Order.
B.6 Accepted sampling plots

Each plot will be saved under one data file during each visit. *Once a file is created and named, this file will not be closed until all points within the plot are measured (i.e. centroids and all corner and cardinal points).* Alternatively, staff could collect centroids for all plots first and then during another instance delineate and collect the remaining points in a new file. In this instance the second .ssf file created will be labeled DXX_Sitecode_MOrder_plot type letter_GPS_V2.

B.7 Shifting and offsetting point locations

Determine plot centroid/origin

If a plot centroid/origin falls on a location where it is not feasible to place a permanent marker (e.g. a rocky outcrop), the field crew may shift the centroid to avoid an obstacle provided that the direction of the shift is selected to minimize the deviation from the provided point (i.e. the closest suitable location), within the specifications below.

Maximum distance of shifts by plot type:

- Distributed Base and Tower Base Plots can be shifted ≤ 3 meters (10% of the randomly generated RRQRR cell).
- Phenology Plots cannot be shifted
- Mammal and Bird Grids can be shifted 50m and 150m respectively but new locations must be approved by Science staff due to additional buffers.
- Tick Plots can be shifted 15m but new locations must be approved by Science staff due to additional buffers.
- Mosquito Points can be shifted up to 10m.

Record compass direction, distance of shift, and rationale in the comments section of the data dictionary.

*Shift:* used to describe how much a marker can be moved from the desired point so that it can be placed in the ground and coordinates collected at that shifted location.

*Offset:* used to describe placing of a marker at some recorded distance and direction from the desired point; the high resolution coordinates are collected at the original point, not at the offset. The azimuth and direction to the marked offset from the desired point must be recorded in the comment section of
the metadata. Also record this information in a place that will be available to staff when they re-visit the plot. Offset information should also be written on the marker in the ground.

Centroid points

In the event that a plot centroid must be shifted, record the compass direction (azimuth from True North) and distance of the shift, and the rationale for the shift in the metadata; then proceed to collect high resolution GPS point data for the new location. Build out the rest of the plot with the new centroid as a starting point. If the plot origin is shifted up to 3 meters and a marker still cannot be placed, you can keep the 3 meter shift and offset the marker up to 4 meters. If the offset is not enough to negotiate around an obstacle, reject the plot, record the rationale for rejection, and select the next available RRQRR generated contingency plot. Shifts and offsets can be used separately or in tandem depending on site conditions.

Points at corners and cardinal directions

If an obstacle prohibits placement (e.g. there is a rock or tree) of a corner or cardinal marker, shift the plot marker to a better location that is ≤ 0.5 m from the target location, record the rationale for the shift in the metadata comments field, and record high resolution GPS data for the new location. If a plot marker cannot be placed ≤ 0.5 m of the target location proceed to offset the marker up to 4 meters.

It is acceptable to increase this 4 m offset distance threshold, however, if there are more than 5 plots with an offset between 4 - 10 m or if at least 1 plot offset is more than 10 m, establish the offset and contact Science.

If the offset is not enough to negotiate around an obstacle, reject the plot, record the rationale for rejection, and select the next available RRQRR generated contingency plot.
SOP C  Plot Delineation and Marking

The following procedure contains instructions followed by a bracketed number [#] that refers to the pointID. Plot pointID numbering is available in 8Appendix G and delineation schematic are in 8Appendix D and 8Appendix F.

Before getting started

- **Check compass and Laser Rangefinder declination.** Make sure the compass and rangefinder have their **declination set appropriately for the geographic location**. Declination changes through time so must be looked up annually for a given location. An incorrect declination will result in shifted plots that will need to be re-delineated.
  - Magnetic declination adjustment values are available at [http://www.ngdc.noaa.gov/geomagmodels/Declination.jsp](http://www.ngdc.noaa.gov/geomagmodels/Declination.jsp)

- **Calibrate Rangefinder internal compass against compass.** Ensure that the internal compass of the Rangefinder has been properly calibrated by checking it against a standard mirror-site compass in more than one direction.
  - If the internal compass of the Rangefinder is not accurate, follow the calibration steps listed in the ‘Configuring the rangefinder’ topic in RD[19].
  - When measuring distances be sure to be in the Horizontal Distance (HD) mode. Press either the ▲ or ▼ button until HD appears in the viewfinder.
  - When checking compass calibration, take care that no metal objects are within 18 inches of the compass or the Rangefinder—i.e. plot markers, watches, etc.
  - The magnetic environment around certain buildings will completely prevent accurate compass calibration in the Rangefinder.

- **General Rules**
  - **Measurements:** The goal is to create plots of constant area when viewed from the air. Use tape measure to delineate the plot unless site conditions make using the tape impractical (e.g. steep slope, dense understory). If using tape measure is not possible, use the rangefinder to delineate the plot. Use the rangefinder in slopes over 20%. When establishing a plot where the slope of the ground is greater than 20%, measuring a distance of 10 m along this slope with a tape will yield a horizontal line that measures less than 10 m from the air. The same can be true if the tape has to go around large trees or over/below brush, see obstruction methods in Appendix H.
    - Gullies and hills will, if large enough, require use of the rangefinder in order to meet this requirement.
  - **Verification:** when using the tape measure or rangefinder to delineate, use the rangefinder to verify measurements. If only the rangefinder is used additional verifications can be made by measuring from different angles/locations.
It is required that verification measurements are within \( \pm 1 \) degree for the azimuth and \( \pm 0.3 \) meters for the distance. For example, if the instrument is verifying a horizontal distance measured previously with the tape of 10.0 m, the rangefinder values for verification should be between 9.7 and 10.3 meters to accept the verification.

- **Plot delineation reminders:**
  
  - Always make sure the internal compass of the rangefinder is properly calibrated and declination is properly set before beginning.
  - Measure in increments of 10m or less. Greater distance results in more errors for the tape and rangefinder.
  - Always keep metal objects (including flags, chaining pins, cell phones, watches, jewelry etc.) at least 2 feet away from the rangefinder when using the internal compass.
  - If you do use a sighting compass abide by the following rules to ensure accuracy:
    - Check to ensure the adjustable declination dial is set correctly.
    - Hold the compass at arms-length and keep all metal objects away.
    - Make sure the compass is held level to allow free movement of the magnetic needle.
    - Align the line in the mirror with the center of the needle while sighting your target.
    - Carefully align both sides and the points of the needle with the guides below it.

Bring the Log Sheets (Appendix A) and fill them out once a plot has been delineated.

Although plots are a variety of sizes, all follow a combination of the following four delineation workflows. Tower Base Plots, Distributed Base Plots, and Tick Plots must all be delineated. Phenology Plots, Bird Girds, Mammal Grids, and Mosquito Points all involve using pre-loaded points in the Trimble to place markers on the ground. This delineation process is outlined based on a two person crew:

- Person 1 holds the rangefinder and measures angles and distances and
- Person 2 holds the reflector.

Both crew members should have tapes, a handful of flags and chaining pins. The numbers in brackets below refer to the pointIDs, see appendix H for more information.

1. **Establishing Cardinal Positions- 10m**
   
   a. Person 1, stand at the centroid with the Rangefinder and tape anchored at centroid [41]
   b. Person 2, take a compass bearing North (360/0°) and walk unspooling tape to 10m [50]
   c. Person 2, turn toward centroid, hold up reflector (away from face) directly above tape at 10m for Person 1

![Figure 9. Plot Delineation step 1](image)
1) Person 1, shoot azimuth and distance to reflector, fine tune Person 2 to the targeted azimuth position (e.g. 180°), then verify measurement including the instrument error of ±1 degree.

2) Person 2, place a flag at the 10m N point [50]

d. Spool the tape to the centroid and complete repeat steps a-c for the remaining cardinal directions: South [32] 180°, East [42] 90°, West [40] 270°.

1. Establishing Cardinal Positions- 20m

   a. Person 1, stand at the centroid with the rangefinder and tape anchored at centroid.

   b. Person 2, take a compass bearing North (360/0°) and walk unspooling tape to 10 meters [50]

   c. Person 2, turn toward centroid, hold up reflector (away from face) directly above tape at 10m for Person 1
      1) Person 1, shoot azimuth and distance to reflector, fine tune Person 2 position
      2) Person 2 place a flag at the 10m N point [50],

   d. Continue 10m N to establish the 20m N point [59]
      1) Person 1, stand at point [50] with the Rangefinder and tape still anchored at the centroid [41]
      2) Person 2, take a compass bearing North (360/0°) and walk unspooling tape to 20m [59]
      3) Person 2, turn toward point [50], hold up reflector (away from face) directly above tape at 20m for Person 1
      4) Person 1, shoot azimuth and distance to reflector, fine tune Person 2 position
      5) Person 2 place a flag at the 20m N point [59]

2. Establishing 20m by 20m corners

   f. Establish North 20m x 20m plot corners
      1) Person 1 and Person 2 each anchor a tape at East [42] and West [40] respectively with a chaining pin.
      2) From points [42] and [40], each person walks north (estimate visually) 10m
      3) Place chaining pins at the NE and NW corners [51] & [49], wrap tapes around pins
      4) Turn 90 degrees toward the center line [50] (meet in the middle)
      5) Anchor tape at 20m
      6) Adjust corners [51 & 49] so that both sides of the tape are taut and the pins are placed precisely at 10m
      7) Once the tape is properly placed, mark corners [51 & 49].

   g. Verify north layout of 20m x 20m plot
      1) Person 1 stand at NW corner [49], Person 2 move to center [41]
         a) Person 1 measure horizontal distance between the NW plot corner and the centroid. Diagonal should measure 14.14 ± 0.3 meters.

   h. Repeat at NE corner [51]
   i. Spool tapes
   j. Establish south 20m x 20m plot corners
      1) Facing south from points [42] and [40], follow step 1 above to establish SE [33] and SW [31] corners.

   k. Verify south layout of 20m x 20m plot
      1) To verify southern layout, follow step 2 above to verify SE [33] and SW [31] corners.

3. Establishing 40m by 40m corners

The remainder of the plot may be completed relying on the tapes, only using the RangeFinder to verify diagonal distance.

   a. Anchor 2 tapes to NW corner [49]
   b. Walk one tape 10m North [58], verify with the Range Finder shoot azimuth (360°) and 10m distance.
   c. Place chaining pin on tape at the 10m.
   d. Walk the other tape from NW corner [49] to the West [48] 10m, verify with the Rangefinder shoot azimuth (270°) and 10m distance.
   e. Place chaining pin on tape at the 10m.
f. Wrap both tapes around 90 degrees, walk toward Northwest most corner [57]
g. Clamp both tapes at 20m intersecting the tapes at Northwest corner [57]
h. To verify layout, stand at corner [57] and shoot the Rangefinder HD back from corner [49]; the distance should = 14.14m
i. Adjust if needed
j. Flag point
k. Repeat steps to establish remaining points:
   1) [51], [60] & [52] → [61]
   2) [33], [34] & [24] → [25]
   3) [31], [30] & [22] → [21]

C.1 Tower Plots

Tower plot dimensions depend on vegetation type and will be listed on the site datasheet (see Table 5). See B.7 for guidance on offsetting markers.

20m by 20m Tower Plot

1. Follow: Establishing Cardinal Positions- 10m (Step 1).
2. Follow: Establishing 20m by 20m corners (Step 3).
3. Leave markers and collect GPS points at [41], [49], [51], [31], [33].
4. Use the GPS to take photos facing toward center from points [49], [51], [31], [33].
5. Fill out log sheet (8Appendix A).

20m by 20m Tower Plot with 40m corners for Soil Sampling

1. Follow: Establishing Cardinal Positions- 10m (Step 1).
2. Follow: Establishing 20m by 20m corners (Step 3).
3. Follow: Establishing 40m by 40m corners (Step 4).
4. Leave markers and collect GPS points at [41], [49], [51], [31], [33], [57], [61], [21], [25]. See SOP B.7 for guidance on offsetting markers.
5. Use the Trimble GPS to take photos facing toward center from points [49], [51], [31], [33].
6. Fill out log sheet (8Appendix A).
40m by 40m Tower Plots

1. Follow: Establishing Cardinal Positions- 20m (Step 1 and 2).
2. Follow: Establishing 20m by 20m corners (Step 3).
   - Suggestion: Flags may be left at all 20x20m corners within 40m tower plots (where sites permit), until tower plots with plant diversity sampling are accepted.
3. Follow: Establishing 40m by 40m corners (Step 4).
4. Leave markers and collect GPS points at [41], [57], [59], [61], [43], [25], [23], [21], [29]. See SOP B.7 for guidance on offsetting markers.
5. Use the Trimble GPS to take photos facing toward center from points [57], [61], [21], [25].
6. Fill out log sheet (8Appendix A).

40m by 40m Tower Plots with 20m corners for Plant Diversity Sampling

1. Follow: Establishing Cardinal Positions- 20m (Step 1 and 2).
2. Follow: Establishing 20m by 20m corners (Step 3).
3. Follow: Establishing 40m by 40m corners (Step 4).
4. Leave markers and collect GPS points at [41], [49], [51], [31], [33], [57], [59], [61], [43], [25], [23], [21], [29]. See SOP B.7 for guidance on offsetting markers.
5. Use the Trimble GPS to take photos facing toward center from points [57], [61], [21], [25].
6. Fill out log sheet (8Appendix A).

C.2 Tower Phenology Plot

Located within the tower airshed (RD[09]). See workflow sheet in 8Appendix D.

1. **Primary Phenology Plot**: 8 points every 100 meters around square transect.
   a. Navigate to preloaded points with GPS receiver.
   b. Place primary markers at the SW and NE points, the remaining points require secondary markers.
   c. Collect GPS points (refer to SOP D)
   d. Use the GPS to take photos in a clockwise direction at all points
   e. Marker type and labeling instructions located in 8Appendix D. See SOP B.7 for guidance on offsetting markers.
   f. Fill out log sheet (8Appendix A).
2. **Secondary Phenology Plot**: line contains three points. Not applicable for all sites (refer to tower data sheet in FOPS folder).
   a. Navigate to preloaded points. Place primary marker at SW corner, remaining points require secondary markers.
   b. Collect GPS points (refer to SOP D)
   c. Use the GPS to photos in a clockwise direction at all points
d. If possible, place temporary flags as needed along transect to visually guide phenology sampling efforts. For more details, refer to RD[09].

e. Marker type and labeling instructions located in Appendix D. See SOP B.7 for guidance on offsetting markers.

f. Fill out log sheet (Appendix A).

Distributed Plots

C.3 Distributed Base Plot

1. Follow: Establishing Cardinal Positions- 20m (Step 1 and Step 2).
2. Follow: Establishing 20m by 20m corners (Step 3).
3. Follow Establishing 40m by 40m corners (Step 4).
4. Leave markers and collect GPS points at [41], [49], [51], [33], [31], [61], [25], [21], [57].
5. Use the GPS to take photos facing toward center from points [49], [51], [31], [33].

C.4 Distributed Tick Plots

Once at the plot verify that at least 50% of the plot perimeter (i.e., 80m of the 160m perimeter) is amenable for tick sampling using the dragging or flagging method(s) (or both). For example, sections of the perimeter that run through dense patches of briars likely cannot be sampled by either method. Additional information can be found in RD[06].

1. Follow: Establishing Cardinal Positions- 20m (Step 1 and Step 2).
2. Follow: Establishing 20m by 20m corners (Step 3).
3. Follow: Establishing 40m by 40m corners (Step 4).
4. Leave markers and collect GPS points at [41], [57], [61], [25], [21].
5. Fill out log sheet (Appendix A).
C.5 Distributed Mammal Grid

See workflow in Appendix 8D.7.

1. **Locate the desired plot centroid** with GPS receiver, using pre-loaded waypoints and/or data files.
2. **Mark the plot centroid.**
3. **Locate the plot corner** with the GPS receiver, using pre-loaded waypoints and/or data files.
4. **Mark plot corner**
5. **Repeat steps 3-4 for remaining corners.**
6. **Set up grid before sampling** as outlined in Small Mammal protocol.
   a. **Note:** The plot corner flags are meant to act as a guide when setting up the grid and do not indicate the final position of the traps.
7. Fill out log sheet (8Appendix A).
C.6 Distributed Bird Grid

See workflow in 8D.8.

1. Locate the desired plot centroid with GPS receiver, using pre-loaded waypoints and/or data files.
2. Mark the plot origin, if the latter is not yet available use a temporary marker.
3. Collect GPS point
4. Bird Grid preloaded points will be provided for use when sampling.
5. Fill out log sheet (8Appendix A).

C.7 Distributed Mosquito Point

See Workflow in Appendix D.10.

1. Locate the point with GPS receiver, using pre-loaded waypoints and/or data files.
2. Validate the point
   a. Point must be at least 5m from a road and a maximum distance of 45 m.
   b. Shift the point within 10m in any direction if needed to find an acceptable hanging structure and/or increase distance from the road. For more details, refer to RD[05]
   c. Validate the vegetation within a 40m by 40m box around the point following the canopy cover assessment of SOP B. Exclude the road during this assessment, for example if 30% of the 40 by 40 m plot is road, exclude this 30% and assess the plot based on the remaining 70%.
   d. Fill out the data dictionary
3. If accepted mark the point with a primary marker, use a temporary marker if primary marker is not yet available.
4. Collect the GPS point
5. Fill out log sheet (8Appendix A).
SOP D Collect GPS coordinates

After delineating a plot, GPS coordinate collection follows. To collect highly accurate coordinates, set up a surveyor style standing GPS system:

1. Monopole set up:
   a. Set up monopole directly on top of the point to be measured
   b. Add bipod legs to ensure stability.
2. Connect the antenna and GPS:
   a. Connect cable to the antenna.
   b. Screw antenna to the top of the monopole.
   c. Connect the other end of the antenna cable to the GPS unit; connector is located in the upper right side of the unit.
   d. Open the monopole clamp and attach it to the monopole.
   e. Open the GPS clamp and attach it to the GPS unit.
   f. Attach the GPS clamp to the quick release mount in the monopole clamp.
   g. Make sure the system remains stable.

![GeoXH 6000 set up for high accuracy data collection.](image)

Figure 14. GeoXH 6000 set up for high accuracy data collection.
Table 6. Points to be logged by FOPS (also see workflow for each plot type in Appendix D).

<table>
<thead>
<tr>
<th>Plot_Type</th>
<th>Sub_Type</th>
<th>Module</th>
<th>Provided by Science</th>
<th>GPS points collected by FOPS for Post Processing</th>
<th>Total Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributed</td>
<td>Base</td>
<td>Base</td>
<td>Centroid</td>
<td>Centroid, 4 corners of 20m plot, 4 DSA corners (40m)</td>
<td>9</td>
</tr>
<tr>
<td>Distributed</td>
<td>Collocated</td>
<td>Mammal</td>
<td>Centroid, corners</td>
<td>Centroid</td>
<td>1</td>
</tr>
<tr>
<td>Distributed</td>
<td>Collocated</td>
<td>Bird</td>
<td>Centroid, 9 pt grid (includes centroid)</td>
<td>Centroid</td>
<td>1</td>
</tr>
<tr>
<td>Distributed</td>
<td>Collocated</td>
<td>Mosquitoes</td>
<td>Centroid</td>
<td>Centroid</td>
<td>1</td>
</tr>
<tr>
<td>Distributed</td>
<td>Collocated</td>
<td>Ticks</td>
<td>Centroid, 4 Corners</td>
<td>Centroid and 4 Corners</td>
<td>5</td>
</tr>
<tr>
<td>Tower</td>
<td>Type A</td>
<td>Tower-40m by 40m</td>
<td>Centroid</td>
<td>Centroid, 4 outer corners, 4 cardinal points</td>
<td>9</td>
</tr>
<tr>
<td>Tower</td>
<td>Type A</td>
<td>Tower- 40m by 40m with plant diversity</td>
<td>Centroid</td>
<td>Centroid, 4 outer corners, 4 inner corners, 4 cardinal points</td>
<td>13</td>
</tr>
<tr>
<td>Tower</td>
<td>Type A</td>
<td>Tower-20m by 20m</td>
<td>Centroid</td>
<td>Centroid, 4 corners</td>
<td>5</td>
</tr>
<tr>
<td>Tower</td>
<td>Type A</td>
<td>Tower- 20m by 20m with DSA corners</td>
<td>Centroid</td>
<td>Centroid, 4 inner corners, 4 outer corners</td>
<td>9</td>
</tr>
<tr>
<td>Tower</td>
<td>Type B</td>
<td>Phenology 1H</td>
<td>8 pts on transect</td>
<td>8 points along transect</td>
<td>8</td>
</tr>
<tr>
<td>Tower</td>
<td>Type B</td>
<td>Phenology 2H</td>
<td>3 pts</td>
<td>3 pts</td>
<td>3</td>
</tr>
</tbody>
</table>
3. Acquire GPS location
   a. Begin the collection of the first point within the plot:
      1) Make sure that the Antenna **Height** is at 2 m, and the **Type** refers to the Antenna Model. Keep setting on “measure to bottom of receiver”; then click **OK** on “confirm antenna height” pop-up.
         a) If the antenna type you are using is not in the drop down menu select “unknown external”

         Tip: To check if the external antenna is properly connected, navigate to the status screen (the one that shows the current coordinates). Move the trimble unit but not the antenna to see if the coordinates change.

      2) Open the first feature of the current file (generally centroid point or other origin point is the first)

         To ensure High-Accuracy Logging
         Make sure your values are:
         - Position Dilution of Precision (PDOP) is \( \leq 6 \).
         - The Signal to Noise Ratio (SNR) should be \( \geq 4 \).
         - Number of satellites used \( \geq 4 \).

         These measurements are located on the bottom right of the **MDD > skyplot** in the TerraSync software on the Trimble unit.

      3) Allow the GPS to log positions (note the logging symbol in the upper right side of the screen). Depending on the canopy cover choose the appropriate action:

         - **Open field or minimal canopy cover**: record GPS data for at least 120 logs using the accuracy-based logging feature.
           o If the data collection of each point takes over 20 minutes, disable logging feature (see below) and collect the 120 logs regardless of accuracy. Once you are back at the domain office please contact Science and provide the list of plots with this issue.

         - **Semi-open and closed canopy**: record GPS data for at least 300 logs using the accuracy-based logging feature.
           o If the data collection of each point takes between 5 and 10 minutes, disable the logging feature (see Box 1) and collect the 300 logs regardless of accuracy. Once you are back at the domain office please contact Science and provide the list of plots with this issue.
Use your judgment in regards to exactly how long to wait at each point (always a minimum of 5 minutes). Create your judgment by assessing potential permanent obstructions like canopy cover, boulders, mountains etc., and based on any preceding results from post processed data received from SCIENCE (when available).

- For all canopy conditions:
  - Verify that carrier lock and a minimum estimated accuracy of 0.5 m is maintained for the duration of the logging. If accuracy drops check that the skyplot information is following high accuracy standards. To view carrier lock scroll to **Status** in the upper left drop down and the scroll to **Receiver** in the lower left drop down menu.
  - Following the completion of the first day of collection under closed canopy or semi-open canopy conditions, notify HQ to verify that the accuracy requirements are being met. **Note:** it takes 24-48 hours to post-process data. After the post-processing accuracy check, you may be required to log more data to meet accuracy; this depends upon plot conditions.

This feature is already enabled if you completed the GPS Setup in SOP A.

4. Tap **Done** to store data. Close the feature but **NOT** the data file.
5. The following screen should return to the display all features that a required to be completed for the plot at work.
   a. There are several scenarios that could follow. Select the appropriate one:

   - If you are at the center point, once this first point is collected and the feature is closed move the monopole to next feature.

   **Or**

   - If a picture follows the work flow, you can take the picture while the GPS is attached to the monopole. Make sure pictures are always taken facing the center of the plot. To take a picture open the photo feature, tap on the **photo icon** to the right of the blank box. To take the picture tap on the physical **camera button** located towards the bottom center of the GPS underneath the screen. Once a photo is taken tap **OK/Done**. For phenology plots take the photo clockwise towards the next point on the transect. Be sure that photos are clear and portray the landscape only (i.e. no technicians or backpacks).

   **Or**
- Once the last point in the plot is collected **Close** the file and **Save** all changes. Collect all equipment and hike to the next plot.
- **Optional:** To quickly verify that all required points have been collected, before closing the file:
  - Use the MDD to view the Map.
  - Zoom to the area where your plot is located.
  - Visually confirm that all features have been collected (each logged feature will be displayed as an “X” on the map)
  - Photo icons will only be displayed if logs were taken while the photo feature is open, which will not always be the case

### Box 1. Disabling the Accuracy-Based Logging Feature

1. Go to MDD > Setup
2. Click on Logging Settings
3. Under Logging Settings click on the wrench 🛠️ to the right of the screen.
4. Scroll down and in the Use Accuracy-based Logging click No
5. Click Done for the two following windows and,
6. To go back to the data collection go to MDD>Data + SDD>Existing File.

By disabling this feature, the GPS will collect data of any accuracy. For information about setting up the accuracy based logging feature see Appendix B, step 4.
SOP E  Data Entry and Verification

As a best practice, field data collected on paper datasheets should be digitally transcribed and transferred to the shared folder for post-processing by Science staff as soon as possible following plot establishment. Ideally this will occur daily at sites where internet access is available. However, given logistical constraints, the maximum timeline for entering data is within 14 days of collection. See RD[04] for complete instructions regarding manual data transcription.

Once back from the field, make sure to:

- Transfer data from GPS handheld to computer (see section SOP E.1).
- Update all fields in the FOPS drive for:
  - XX_X_TOS_Plots_Datasheet (e.g. 05_C_TOS_Plots_Datasheet). The naming convention and format of this document are subject to change.
- If it is the first day of collection under a closed or open canopy forest, through e-mail, notify Science that there is data available for post processing.

E.1  Transferring data from GPS handheld to PC

There are two methods to transfer files to and from the Trimble unit; using a SD media card and connecting directly to the computer through a cable. Due to frequent updates, the cable method instructions are updated in service now and links can be found in the sampling support library.

SD Card method:

1. Transfer all the raw Trimble data into a folder on the computer. The extensions will be .car, dd, .gic, .gix, .giw, .gip, .obx, .obs for each file, 8 total.
2. Create a blank folder to transfer the files too. Call it “ssf”.
3. Open GPS Pathfinder Office. Go to Utilities> Data Transfer.
4. Click the Red “X” so it stops looking for a Mobile Device

![Figure 15: GPS Pathfinder Data Transfer](image)
5. Click on “Devices”
6. Click on “New”
7. Scroll down and select “GIS Folder”

8. Browse to the folder containing the raw data, click “Next”
9. Specify the type and version and click “Next”
   a. Type will be TerraSync
   b. Version will be v3xx, v4xx, v5xx
10. Name the setup and click “Finish”
11. Selected the new device you just created and click “Close”.
12. Click on the Green Check and the data transfer will connect to the folder

13. Once connected click “Add” and then “Data File”
14. Specify the destination (to place the .ssf) and select the files you want to transfer and click “Open”
15. Click “Transfer All” and the data transfer will transform the raw data to .ssf files

Make sure all files are transferred to the shared folder. Science staff will post process the data files.

If certain points don’t meet the accuracy requirements, the corresponding points will have to be re-measured.
E.2 Data Verification

Once the data is transferred complete the following quality checks:

1. Make sure that the data file is correctly named, see SOP B.3. To view filenames go to the folder where files were downloaded.

   If the filename is incorrect, make sure that the name is changed in the GPS unit before transferring the data to the computer. This ensures that the original, backup, and photo files all follow the same naming convention.

   a. Turn on the GPS unit
   b. Open the Terra Sync Software
   c. Once in Terra Sync, tap on the MDD (Main Drop Down) menu located to the upper left side of the screen and select Data.
   d. Tap on the SDD (Sub Drop Down) menu located beneath the MDD and select Manager.
   e. Below the SDD there should be a box with the list of existing data files, select the file to be renamed.
   f. Once the file is selected, tap on the options menu located parallel to the SDD in the upper right side of the screen and select the Rename option.
   g. The screen will display the file in question highlighted
   h. Edit the datafile name
   i. Once the rename is complete, tap outside of the filename highlighted area and this should establish the new name of the file.
   j. Once the datafile name is modified, transfer the file to the computer through the Pathfinder transfer tool (see SOP E.1 for instructions)
   k. Make sure that the incorrectly named files are deleted from the shared folder.

2. Make sure the spatial location of the point ID is accurate, for example: point ID 41 should be in the center of the plot. To do this spatial check open the .ssf file in Pathfinder office. To view the spatial location go to the main pane of Pathfinder and click on View > click on Map. To view the pointID in the file go to the main pane and click on Data > then click on Feature Properties.

   If the point ID is incorrect make sure an e-mail is sent to Science staff with both the incorrect pointID and the intended pointID.

3. Send your Science point person an e-mail to notify them about the added data ready for post processing.

4. Update the worksheet daily (Table 5 in folder “Site_Information_&_Datasheet”). See SOP A, section A.7 for more information.
E.3  Post-hoc mission analysis: Working for higher accuracy in challenging locations

Once the collected GPS data are sent to Science, they will be post processed and assessed to determine if points meet the accuracy standards. Field technicians will recollect any data that require re-measurement. If re-measurement is required the mission planning can be a useful tool to make sure that measurements will be collected at the best time of the day. Please complete the following steps for mission planning when re-measurement occurs:

1.  Go to http://www.trimble.com/GNSSPlanningOnline/#/Settings
2.  To begin, click on the Setting link located in the upper left side of the window:
   a.  Add the latitude and longitude of one of the plots within the site to visit. Look in (RD [50]) for the latitude and longitude.
   b.  If the challenging areas are located close to obstructions like mountains, cliffs, or valleys use the Obstructions tool to define the open sky area available. Make sure the azimuth where the obstruction occurs is acquired. For example if there are mountains within sight located at 95° azimuth and 20° elevation:
      1)  Start by clicking on the blue circumference on the area around 95° where the obstruction occurs. The blue circumference (represents a clear sky view) will allow the modification of the view. Modifying the blue circumference to align with the actual sky view available at a particular location of measurement will allow for a better assessment of satellite availability.

![Figure 19. The Obstructions tool within the Trimble Mission Planning web-based software](image-url)
2) After clicking on the line, several nodes should appear. There are two ways to apply the azimuth and elevation to the central node:

- To the right center of the screen there should be three items representing the three nodes, with specs on the azimuth and elevation. Click on the pencil icon in the second item (should represent the central node) and type the azimuth and elevation, press Enter, the obstruction curtain should be recorded.

Or

- **Drag the center node** to 95°. Once the node is in the right place, use the same center node and **drag it inward**, to a window should appear to the right and the second item should reflect the azimuth and elevation of the moving target. Make sure that the node ends up at 95° azimuth and 20° elevation. Don’t worry about the outer nodes unless the width of the obstruction is significantly different than the one shown on the circumference.

![Image](image.png)

**Figure 20.** Adding an obstruction observed in the field within the Trimble Mission Planning software.

3) Once the desirable obstruction curtain is created click **Apply** and an updated satellite histogram should be created.

c. Select the field **Day**
d. Select the starting time or **Visible Interval** and the time span in hours (generally a 6 or 12 hour span).
e. Select the appropriate **Time Zone**.
f. Click **Apply**
3. Click on the **Satellite Library**
   a. Click on the **GPS** and the **GLONASS** satellite libraries; unclick the rest of the satellite libraries.

4. Click on the **Number of Satellites**

   This histogram will display the number of satellites (GPS and GLONASS) available on the day and times previously set up in the settings window. The higher the number of satellites available, the better the accuracy will be. This graph will allow field workers to know when the best times to establish challenging plots may or may not be.

   If there is a time in the day where satellite availability is poor, take this time to hike or do activities other than collecting coordinates.
SOP F   Re-visitoring GPS locations

F.1   Re-measuring GPS locations

If a point does not meet the required accuracy the first time around, the following steps will be used either separately or in combination during subsequent re-measurements. If applicable, a list of points that have to be re-measured can be found on the second tab in the site-specific datasheet. In most cases FOPs will be asked to attempt re-measurement up to 4 times.

1. Wait until leaf off canopy
   a. If the point that needs to be collected is under deciduous leaf canopy the best solution is to wait until the leaves drop and there is no longer any canopy cover.
2. Double or Triple the amount logs. In some cases this could be as many as 800 to 1000 logs per high-accuracy point.
3. Utilize mission planning
4. Even one or two additional satellites can make a huge different in reaching accuracy
5. Utilize the carrier time technique.

This method utilizes open canopy areas for satellite communication before collecting logs in the closed canopy. Staff will either need two GPS units (one for logging, one for navigating) or be able to re-locate the re-measurement point from an open canopy location without the use of a GPS unit.

- In open canopy make a new file, click create, confirm the antenna height, and choose point generic.
- Without logging points wait until you have at least two minutes of carrier lock. To view carrier lock scroll to Status in the upper left drop down and the scroll to Receiver in the lower left drop down menu.
  - Note: Two minutes of carrier time might take longer than two minutes to acquire
- Once you reach two minutes, hike to the point that will be re-measured without closing the file you just created.
- At the point log the appropriate number of logs and pause the logging.
- Without clicking “done” or closing the file return to the open canopy area and wait until two minutes of carrier time is obtained.
- Close the file.

At certain sites it is not possible to meet the science accuracy requirements through the current workflow due to factors entirely out of the control of the field teams collecting the data (e.g. rugged topography, blocked horizons, a lack of CORS stations by which to post-process). Reference Appendix J about utilizing a base station and work with Science staff to determine the best path forward for your particular site. Some indications that a base station may be necessary are:
• If your re-measurement rate is over 30%
• If entire plots are requiring re-measurement
• Post processed accuracies are routinely above 1m
• There are no CORs or state base stations within 200km of the site

While these indicators are not always available to operators working in the field, should technicians find themselves in a situation where a site requires an extremely high rate of re-measurement they should bring it up with Science.

F.2 Lost Plot Markers

If markers cannot be located on subsequent visits to the plot after establishment has occurred, use the steps below to re-mark the plots. The goal is to maintain sampling from a replicable location over the lifetime of the plot. Plots that have cell phone service will take advantage of real time navigation. Plots without cell phone service will use a combination of remaining plot markers and vegetation structure tags to re-delineate the missing point.

If a point is frequently missing, work with your domain manager to determine if a different marker type would work better in that location. For example:

• Fire disturbance- Replace plastic markers with aluminum
• Cow disturbance- Replace above ground markers with below ground markers.

Be sure to check with permitting and the site host to see if there are any restrictions.
Does the plot have cell phone service?

**NO**

Is the plot a Tower Base, Distributed Base, or Phenology Plot?

**NO**

Follow the steps in F.2.4 to remark the point using the CEA (use real time navigation if available). Record lost plot marker metadata.

**YES**

Follow the steps in F.2.2 to use Real Time Navigation.

Navigate to the missing point.

Is the CEA 1 m or less?

**NO**

**YES**

Navigate to the missing point.

Are there other plot markers and/or vegetation structure tags remaining in the plot?

**NO**

Re-establish the plot using SOP C and D. See F.2.5. Record lost plot marker metadata.

**YES**

Triangulate the missing marker location using at least 2 remaining points—either plot markers or veg. structure tags. See section F.2.3. Record the lost plot marker metadata.

**YES**

Place the marker in the ground. Record the lost plot marker metadata.

*Figure 21. Lost Plot Marker Workflow. Note: CEA = Current Estimated Accuracy*
F.2.1 Lost Plot Marker File Name, Metadata, and Equipment

Equipment:

Since cell phone coverage can be inconsistent across a site, be prepared to re-establish markers utilizing all methods. In addition to the normal equipment needed for plot establishment (Section 6) you will need to bring a mobile device that can connect to Fulcrum. Before heading into the field be sure to import the post establishment .imps provided by science and the Lost Plot Marker Data Dictionary to the Trimble following the steps in section A.5.

File Name:

Regardless of what plot marker re-establishment method is used, use the Trimble unit to record descriptive metadata associated with the lost marker.

GPS logs only need to be collected if the entire plot was re-established because all plot markers and vegetation structure tags were missing; see section F.2.4.

Metadata:

1. To record metadata use the following instructions:
   a. Make sure the file used to hike to the plot has been Closed; if it hasn’t, go to the Menu Drop Down (MDD) > Data and click Done.
   b. Create a new data file for each point. Go to MDD > Data, and then go to the Sub Drop Down (SDD) menu and select New (T).
   c. Keep the settings on File type (Rover) and Location (Default); Click on the File Name field and enter the datafile name.

Files must be named according to the following convention:

1. Filename begins with the letter D, followed by the two digit number for the domain, followed by an underscore: e.g. D01_  
2. Add the four letter site ID followed by an underscore: e.g. D01_HARV_  
3. Add the 3 digit plot ID number: e.g. D01_HARV_002  
4. Add a letter to indicate the plot type followed by an underscore: e.g. D01_HARV_002_T_. Plot type letters are:
   - “T” to indicate a “Tower” Plot.
   - “H” to indicate a “PHenology” Plot.
   - “R” to indicate a “DistRibuted Base” Plot.
   - “K” to indicate a “TicK” Plot.
   - “M” to indicate a “Mammal” Grid.
   - “B” to indicate a “Bird” Grid.
• “Q” to indicate a “Mosquito” Point.

5. Add the point ID: e.g. D01_HARV_002_T_21
   d. In Dictionary Name choose “Lost Plot Marker”
   e. Change antennae height to 2.000 m
   f. Choose the antenna type you are using and click OK
   g. Go back to the MDD>Data screen; once the new file is created open the metadata feature.

2. Fill in the appropriate metadata. Many of the fields are contingent on a previous answer as depicted by the bullets below.
   a. Date: Auto-generate
   b. Operator Name: click on the blank space below and the keyboard should appear, write down the initials of the two crew members.
   c. Why missing? If you able to determine why the plot marker went missing choose from the drop down menu.
      i. Fire
      ii. Land mang.
         1. Logging, Tilling, Re-seeding, etc
      iii. Animal
      iv. Vandalism
       v. Wind
       vi. Fallen veg.
       vii. Unknown
       viii. Other
         1. If “other” is selected fill out the comments box
   d. Real-time Nav?: Was real-time navigation used to replace the marker?
      i. If “Yes”:
         1. CEA: If real time navigation was used what was the CEA (Current Estimated Accuracy) in m?
      ii. If “No”:
         1. Replacement method: If real time navigation was not used how did you replace the marker? The method depends on plot type.
            a. If “Delineation-base plots and phenology”:
               i. Delineation Points: List the plot marker point ids or the vegetation structure tag ids that were used to delineate the missing point. If you needed to re-establish the entire plot note that here.
ii. **Delineation Diff. (m)**: Distance between the two delineation methods in m. See Figure 22.

2. **If**: “Navigation-tick, bird, mammal, mosquito”
   a. **CEA**: navigation post processing CEA in m

   e. **Replace Marker type?**: Did you replace the marker type? I.e. swap out plastic markers in sites with frequent burns
      i. **If “Yes”**:
      ii. **New Marker Type**: Brief description of new marker type

   f. **Comments**: any additional pertinent comments

3. **Photos (camera icon)**: If it could be helpful for future instances when the plot marker is missing take a photo of its location.
   a. Click **Done** to store data. Close the feature and the file.
   b. Back in the office export the metadata and/or GPS files and save to the “Replacing Plot Markers” folder in N:\Science\GISData\FOPs\Domain\Site. Create the folder if necessary.

### F.2.2 Real-Time Navigation

Plots that have cell phone service of at least 3G will be able to take advantage of real time navigation. Since most networks follow state boundaries, each site could require a different base station connection and log in information. This will be provided by Science to each domain when needed.

**Network Test:**

For each site, it may be necessary to test out various networks before re-establishing markers to see which one is most reliable. A real time navigation test should be conducted on a plot with markers before any re-establishment work. If you are able to navigate to a point in good conditions (little to no canopy) within 50cm and the CEA is 50 cm or less than proceed to re-mark points with that network. If either value is greater than 50cm then work with Science to see what other options are available.

It is recommended to test the setup at the office before heading into the field. Network logins and passwords may be shared across domains and scheduling coordination may be necessary.

**Connect to the Internet**

1. Set up the domain cell phone to be a hot spot. If necessary, work with IT and your domain manager to get this activated. This will require different steps for different phones, however for an iPhone:
   a. In settings go to “Personal Hotspot”
   b. Turn the hot spot on
2. Set up the Trimble
a. Click the windows start button on the bottom left of the screen
b. Go to the “Settings” icon (looks like a cog)
c. Go to the “Connections” folder
d. Go to the “Wireless Manager” folder
e. Turn on Wi-Fi by clicking on the grey Wi-Fi box
f. If no networks pop up click the Wi-Fi symbol along the top of the Trimble (green box), and then click the Wi-Fi symbol that pops up in the new tool bar (orange box)

g. Select your phone
   i. Choose “The Internet”
   ii. Choose “Connect”
h. Enter the hot spot network key
   i. Might be named “Wi-Fi password” on your phone
   ii. It is recommended to change all domains to a generic password incase connectivity is lost in the field
3. If you are connected the Wi-Fi symbol at the top of the Trimble will look like this:

![Trimble Wi-Fi symbol](image)

**Figure 23.** Trimble Wi-Fi symbol

**Terra Sync Settings**

In Terra Sync (navigate here from the home screen) choose “Setup” from the drop down in the upper left corner. If a setting is not mentioned here use the normal plot establishment setup.

**Logging Settings**

- **Accuracy settings**
  - Click the wrench
    - First box: Horizontal
    - Second box: Change from “Postprocessed” to “In the field”
    - Use Accuracy-Based Logging = “No”
    - Click “Done”

- **Point/Vertex Auto-pause count:** “None”
- **Set the antenna options (height, type, etc.)** as you normally do
- **Click “Done”**

**Coordinate System**

- **Set the system to “UTM”**
- **Zone:** Fill in for your specific site
- **Datum:** “WGS 1984”
- **Altitude Reference:** “MSL”
- **Click “Done”**

**Units**
• Distance Units: “Meters”

Real-Time Settings

• Change “Uncorrected GNSS” to “External Source”
• Click the wrench
  o Correction Datum
    ▪ This is base station dependent and will be clarified to each domain at the time of re-navigation.
    ▪ If a correction is required:
      • If Terrasync has been updated (version 5.7 or greater), use “ITRF to NAD 1983 (2011)”
      • If Terrasync has not been updated, use “NAD 1983 (Conus) CORS96”
    ▪ If a correction is not required:
      • Use “WGS 1984”
  o Type: VRS
  o Connection Method: Internet
  o Address: Dependent on particular real-time network. Will be provided to each domain.
  o Port: Dependent on particular real-time network. Will be provided to each domain.
  o Source
    ▪ Click the wrench
      o Choose from the list the rows where the name is “…CMR_X” or “…RTCM_31”
      o Click “Done”
        ▪ Note: If a source table cannot be found check to make sure you are connected to the internet
  ▪ Username: Dependent on particular real-time network. Will be provided to each domain.
  ▪ Password: Dependent on particular real-time network. Will be provided to each domain.
  ▪ Connection control = Manual
  ▪ Click “Done”
• Choice 2 “Use uncorrected GNSS”
• Real-time Age Limit = “15 Sec”
• Click “Done”

In the Field

1. Make sure the phone is within 5m of the Trimble unit to maintain connection
2. In “Setup” make sure the “Ext Source” grey box is depressed- orange box in Figure 14.
3. To make sure the real time navigation is on and working:
   a. The real time symbol will stop blinking- green box in Figure 14.
      i. This can takes a minute or two, will need at least 5 satellites
   b. Check the CEA in the far left corner (blue box below). The CEA is dependent on distance
to the base station, satellite configuration, and canopy cover.
      i. If you are testing the network (see “Network Test” at the beginning of this
section) than the CEA should be below 50 cm in open canopy.
      ii. If you have already determined that you are using the best network for your site
            than it is ok if the CEA is over 50cm.

   ![Connection and CEA Locations](image)

4. If the CEA starts to increase or jump around check to make sure the “Ext. Source” button is still
depressed.

**Navigating to the point**

1. Open up the established .imp file corresponding to the site and plot type to find the previously
created location. This file is created after plot establishment has occurred and will be located in
a site specific folder.
2. Choose the point you want to navigate to and navigate to that point using the **antenna setup** in
   SOP D.
3. You have reached your location when the “x” is in the circle.
a. If the CEA and the x are “jumping” around wait up to 20 minutes for the signal to settle. It is problematic when the CEA has large fluctuations of 10cm of greater.

4. If the real time CEA is less than 1m place a new marker in the ground
   a. If the real time CEA is greater than 1m use the steps in F.2.3 to replace the plot marker
      i. Ideally the CEA is less than 1m but up to 1m is acceptable due to distance to the base station, satellite configuration, and canopy cover.
   b. Be sure to use the navigation CEA and not the post processed CEA

5. Record the metadata in the Lost Plot Marker Data Dictionary.

F.2.3 Triangulation Using Remaining Plot Markers and Vegetation Structure Tags

If the plot does not have cell phone service utilize the remaining maker features in the plot to determine the missing point location. Plot markers, vegetation structure tags, or a combination of the two can be used. Use two remaining features in the plot to delineate from.

See Figure 15 below for a schematic that include distances and azimuths between points. Additional figures can be found in Appendix F.

![Figure 25. Distances and azimuths between points](image-url)
• If using the vegetation structure tags use the data in Fulcrum to determine the stem distance and stem azimuth. To access the data in Fulcrum:
  1. Navigate to the (TOS) VST: Mapping and Tagging (PROD) app on the tablet
  2. In list view, the record names include plot ID, tagging ID, subplot ID, and tree type
  3. Click on the three vertical dots in the upper right hand corner and select “Search Records” from the drop down menu
  4. Search by plot ID or vegetation structure tag ID
  5. Click on the record that matches the corresponding plot ID and tagging ID to the tree being used for re-delineation
  6. Scroll to the Stem Data section
  7. Confirm that the tree was measured from a particular point by matching the pointID to the marker that is missing
  8. Lost markers should only be re-delineated from vegetation structure tags that were used to originally measure them
  9. Use the stemDistance and the opposite of the stemAzimuth (add or subtract 180 degrees to the listed value) to determine the location of the missing plot marker

• Delineate from one remaining feature and place a temporary marker and then delineate from the second remaining feature.
• Be sure to use the tape and compass if plot conditions allow.
• If there is a discrepancy between the two delineation points place the new plot marker halfway between the two (i.e. split the difference). Record the difference in the Lost Plot Marker Data Dictionary.
• If the difference between the two delineation points is more than 3.0m delineate from a third plot feature. Use the two closest delineation points when you split the difference.

Each triangle is the delineated location from 2 remaining markers. The difference is 2m apart. The new marker (the X) will be placed at the halfway point, 1m from each triangle.
• If there is only one marker or vegetation structure tag to use delineate from that point twice to serve as a check.
• For phenology plots use plant tags if available. Contact Science if the distance between remaining plant tags and plot markers is too far to delineate.
• Record the metadata in the Lost Plot Marker Data Dictionary.

F.2.4 Navigation to Mammal Grids, Bird Grids, Tick Plots, and Mosquito Points in areas without cell phone service or areas with high real time navigation CEA values

Plots that do not support plant protocols have a larger acceptable uncertainty value. If cell phone service is available continue to use the real time navigation even if the CEA value is over 1 meter. If cell phone service is not available use the post processing CEA value (click on the CEA to toggle back and forth between the real time navigation and post processing value). Navigate to the missing point using the Trimble and place the marker in the ground. Be sure to use the established .imp since tick, mammal, mosquito, and bird points often shift during plot establishment. Record the metadata in the Lost Plot Marker Data Dictionary. If a point or plot seems off please contact Science.

F.2.5 No Plot Markers or Vegetation Structure Tags Remain

If there is nothing to delineate from and there is no cell phone service then re-establish the plot following the steps in SOP C and SOP D. Be sure to use the established .imp to navigate to the centroid location (using real time navigation if possible). Record the metadata in the lost plot marker data dictionary.
SOP G    Sample Shipment

This protocol generates no samples for shipment
SOP H    Plot Monumentation

Monumentation requirements are expected to vary from the standard monuments described in this SOP at many sites and/or NLCD subtypes. In these cases, FOPS personnel should confirm the alternative monuments meet science requirements with Science personnel via NEON’s problem tracking application (e.g. JIRA). Sites in different domains will also have differing requirements for the length of monument rod needed for permanent installations, usually determined by the depth of the frost line or unique substrates, which will need to be determined by domain personnel in conjunction with Science.

H.1    Permanent Marker Installation

1. If permanent monuments are not installed as part of plot establishment, begin by navigating to target plot and corner using a map, GPS, compass, and/or tape measures as needed. Refer to the Appendix A for instructions on which plot corners require permanent monuments. If temporary plot markers are present, use a pry bar to remove them (Fig. 11).

![Figure 27. Removing preexisting plot markers with a pry bar](image)

2. Assemble the initial monument assembly by threading a driving point below a rod and the driving adapter above the same rod section using the supplied threaded connection pins. Pliers can be used to ensure a tight connection between the different sections. Place the monument
assembly with the driving point down into the hole left by the temporary plot marker (Fig. 12). At plots without a preexisting temporary plot marker, lightly tap the monument assembly a few inches into the ground using the sledgehammer as a hand hammer (i.e. grip the sledge hammer very close to the head).

3. Continue to drive the monument into the ground using the post driver. This is a deceptively hazardous action requiring cautious attention to several factors:
   a. Occasionally the rod assembly sections may slightly separate while driving the monument into the ground as the connections tend to move a little counterclockwise during each hit (Fig. 12). Because damage can occur to a rod section or threaded connection pin if a gap forms between the monument assembly sections, frequently pause driving the monument assembly into the ground (approximately every 10-20 strikes) to check for and tighten any loose connections.

   b. Do not lift the post driver too high during the striking motion as this may allow the bottom of the post driver to rise above the top of the monument assembly. This situation is dangerous as the worker could miss the monument on the down stroke of the striking motion and potentially hit their leg with the post driver or hit their hand against the top of the monument assembly (Fig. 13). If the worker can see scored line about 1 inch below the driving adapter (Fig. 12) at any point during the striking motion they are probably raising the post driver too high.

Figure 28. Do not allow the monument assembly sections to become separated while striking
Figure 29. Do not lift the post diver above the top of the rod during the striking motion as the worker could injure their leg or hand.

c. Adjust your body position as needed from a standing to a kneeling stance as the top of the monument is driven closer to the ground. Operating the post driver above your body reduces control of the driver, while operating the post driver below your body may allow the driver to strike the worker in the head.

4. When the monument has been driven far enough into the ground so that A) the post driver almost hits the ground at the bottom of the striking motion or B) the worker is making the striking motion at an uncomfortable height/angle and the required monument rod length has not been reached, unthread the driving adapter from the top of the monument, thread another monument rod section onto the top of the monument assembly in the ground, and thread the driving adapter onto the top of the new monument rod section. Repeat step 3 and 4 until the required monument rod length has been reached.

5. When the monument has been driven far enough into the ground so the post driver almost hits the ground at the bottom of the striking motion and the final monument rod section needed to reach the required depth has already been attached, finish driving the monument assembly close to the final height by repeating step 4 using a spare 2’ monument rod section threaded above the final monument section. Repeat step 3 until the top of the final monument rod section is a few inches above ground level, at which point the driving adapter and spare monument rod section are removed.

6. Place the respective monument cap on top of the final rod section. Use a sledgehammer to seat the monument cap squarely on the final monument rod section and drive the final monument...
assembly to the final desired position (Fig. 14). Ensure the cap is secure after work has been performed.

a. Monument caps cannot be ordered until plot acceptance is done and the unique plot IDS created. Plot IDS are created by Science staff after the final list of accepted plots is available.

![Image of a sledgehammer](image)

**Figure 30.** Use a sledgehammer to seat the cap and drive the rod to the desired position

### H.2 Cutting a Monument Stake

Occasionally a monument is driven to refusal (i.e. the bottom has reached an impenetrable barrier) before reaching the site specific preferred or minimum length, which leaves a length of rod still above ground and must be cut off or removed.

1. If the minimum monument length has been reached, use a hand or power saw to remove any extraneous monument rod.
   a. Use a marker to make a mark at the desired final height of the monument rod.
   b. Pierce the center of a paper plate and push the plate down the monument rod through this hole so the plate is resting on the ground. This plate will serve as a containment area for any metal shavings generated during the cutting process. Properly dispose of the shavings after work has been completed (i.e. at the support facility).
   c. Slowly and carefully saw horizontally through the monument at the height mark, being cautious near the end of the cut to maintain control of the saw and prevent large burrs on the rod.
d. Place the respective monument cap on top of the final rod section. Use a sledgehammer to seat the monument cap squarely on the final monument rod section and drive the final monument assembly to the final desired position (Fig. 14).
8 REFERENCES


APPENDIX A  LOG SHEETS

How to use the Mission Planning/Assignment Sheet

The Mission Planning/Assignment Sheet provides a standardized format for tracking each plot establishment team’s progress on a daily basis:

- As the day’s activities are being planned, each team can write down the plots they should (or might possibly) visit. When possible, it is useful to list the plots in the order they are to be visited so that the team can simply work their way down the list. Fill in as many details about each plot as are necessary to do the work: Morton order number, plot type, NLCD class, etc. If the task list includes a revisit to collect more GPS data, write down the points to be re-logged and the file version to be used (V2, V3, etc.).
- In the field, the team can use the checkboxes and note fields to record progress and any deviations from the expected plan. If the work was carried out according to plan, simply check off the “Task Completed” box. If the team was not able to finish the planned tasks, check “Task Partially Completed” and take notes on what work remains to be done. If the plot is rejected, check off the “Plot Rejected” and record why.
- At the end of the day, the team should finalize any notes and check off “Not Visited” for any plots the team did not make it to. Then use the log sheet to update the “plots datasheet” on the GIS drive and any master checklist or progress map that domain staff may have developed.
- Later on, these log sheets are available as resources to plot establishment coordinators as they try to troubleshoot and track down loose ends, for example: “I have a question about plot X; which technician should I talk to about it?” Or, “I thought we had re-visited that plot to re-log point 23 but I can’t find the file. Was that work never done in the field or did we just miss a file during the data upload? Which GPS unit was used, anyway?”

How to use Plot Maintenance Logs

Plot Maintenance Logs provide a long-term record of plot-specific details that are not otherwise tracked under this protocol. Side one (plot type specific; A.2- A.9) is for documenting the initial plot acceptance/delineation visit. It contains a diagram showing the plot’s configuration and fields for metadata such as Morton order number, personnel who did the work, etc. Side two (marker installation; A.10) contains fields for notes on subsequent visits (for example, to install permanent markers or to seasonally break down/re-establish the plot). The teams performing this later work can either take the original with them and update it in the field (suggestion: scan/photocopy the original first to ensure there is a backup) or update the log sheet in the office at the end of the day.
During plot establishment, each plot acceptance team should carry enough of these sheets to cover all possibilities for the day. Once a plot is accepted, the team can record:

- type(s) of markers used
- location of any offset markers
- locations of streams, boulders, trails, or any other features that might complicate sampling
- suggested route to plot
- metadata such as personnel who accepted and delineated the plot

Many of these details can simply be sketched onto the plot diagram, providing a visual record (see example below). In terms of workflow, a good time to fill out the Plot Maintenance Log might be at the end of the delineation process, when one team member is finishing up the GPS work and other team members are unoccupied.

![Plot Maintenance Log Sheet Example](image)

**Figure 31.** Example of how to use a plot maintenance log sheet
## A.1 Mission Planning and Assignment Sheets

<table>
<thead>
<tr>
<th>Plot Information</th>
<th>Task Information</th>
<th>More Details</th>
<th>Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Notes/Directions</td>
<td>Completion Comments</td>
<td>Plot Acceptance</td>
<td>Plot Accepted/Task Completed</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Tower</td>
<td>Mammal</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Phenology</td>
<td>Mosquito</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Base</td>
<td>Tick</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Bird</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location Notes/Directions</th>
<th>Completion Comments</th>
<th>Plot Acceptance</th>
<th>Plot Accepted/Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>Tower</td>
<td>Mammal</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Phenology</td>
<td>Mosquito</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Base</td>
<td>Tick</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Bird</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location Notes/Directions</th>
<th>Completion Comments</th>
<th>Plot Acceptance</th>
<th>Plot Accepted/Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>Tower</td>
<td>Mammal</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Phenology</td>
<td>Mosquito</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Base</td>
<td>Tick</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Bird</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location Notes/Directions</th>
<th>Completion Comments</th>
<th>Plot Acceptance</th>
<th>Plot Accepted/Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>Tower</td>
<td>Mammal</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Phenology</td>
<td>Mosquito</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Base</td>
<td>Tick</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Bird</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location Notes/Directions</th>
<th>Completion Comments</th>
<th>Plot Acceptance</th>
<th>Plot Accepted/Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>Tower</td>
<td>Mammal</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Phenology</td>
<td>Mosquito</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Base</td>
<td>Tick</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Bird</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location Notes/Directions</th>
<th>Completion Comments</th>
<th>Plot Acceptance</th>
<th>Plot Accepted/Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>Tower</td>
<td>Mammal</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Phenology</td>
<td>Mosquito</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Base</td>
<td>Tick</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Bird</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location Notes/Directions</th>
<th>Completion Comments</th>
<th>Plot Acceptance</th>
<th>Plot Accepted/Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>Tower</td>
<td>Mammal</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Phenology</td>
<td>Mosquito</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Base</td>
<td>Tick</td>
<td>No</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Bird</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
A.2 Distributed Base Plot Log Sheet

PLOT MAINTENANCE LOG

Domain: ______ Site: _______ Morton Order: _______ Plot ID: _______

Plot Map: Distributed Base Plot

Plot Markers Used
- Primary Markers
  Marked With: _______
- Secondary Markers
  Marked With: _______
- Optional Marker Positions
  Marked With: _______

What to Record
- Check off positions where markers installed. Note any offset markers.
- Note pools, streams, boulders—anything that may complicate sampling.

Initial Establishment Visit
Date Accepted: _____________ Field Crew: ________________________________
Trimble GPS Used: ___________ All GPS Points Attempted? □ Y / □ N
Plot Nickname: _______________ Plot Delineation Completed? □ Y / □ N
Comments:

Please be detailed about any GPS points not logged/delineation work still to be done.
A.3 Tick Plot Log Sheet

PLOT MAINTENANCE LOG

Domain:_________ Site:_________ Morton Order:_________ Plot ID:_________

Plot Map: Tick Plot

61
Marker □
Note: Post offset 2.3m @23°

Plot Markers Used
★ Primary Markers
Marked With:

• Secondary Markers
Marked With:

What to Record
• Check off positions where markers installed. Note any offset markers.
• Note pools, streams, boulders—anything that may complicate sampling.

Initial Establishment Visit
Date Accepted:_______________ Field Crew:_____________________
Trimble GPS Used:___________ All GPS Points Attempted? □ Y / □ N
Plot Nickname:_______________ Plot Delineation Completed? □ Y / □ N
Tick Drag/Flag Evaluation (□ Y / □ N): Field technicians will be able to drag and/or flag at least 50% of plot perimeter. (If the answer is “N”, reject the plot!)
Comments:

Please be detailed about any GPS points not logged/delineation work still to be done.
A.4 Small Mammal Grid Log Sheet

PLOT MAINTENANCE LOG

Domain: Site: Morton Order: Plot ID:

Plot Map: Small Mammals Grid

Plot Markers Used
- Primary Markers
  Marked With:
- Secondary Markers
  Marked With:

What to Record
- Check off positions where markers installed. Note any offset markers.
- Note pools, streams, boulders—anything that may complicate sampling.
- Corner points (A1, J1, A10, J10) will be provided in imps, no delineation is done in the field.

Initial Establishment Visit

Date Accepted: Field Crew:
Trimble GPS Used: All GPS Points Attempted? ☐ Y / ☐ N
Plot Nickname: Plot Delineation Completed? ☐ Y / ☐ N
Comments:

Please be detailed about any GPS points not logged/delineation work still to be done.
## PLOT MAINTENANCE LOG

<table>
<thead>
<tr>
<th>Domain:</th>
<th>Site:</th>
<th>Morton Order:</th>
<th>Plot ID:</th>
</tr>
</thead>
</table>

### Plot Map: Bird Grid Centroid

#### Plot Markers Used

- **Primary Markers**
  - **Marked With:**

- **No marker. Not visited during plot establishment.**

#### What to Record

- Check box(es) when marker(s) installed. Note any offset markers.
- Note pools, streams, boulders—anything that may complicate sampling.

## Initial Establishment Visit

Date Accepted: ____________  
Field Crew: ____________
Trimble GPS Used: ____________  
All GPS Points Attempted? □ Y / □ N
Plot Nickname: ____________  
Plot Delineation Completed? □ Y / □ N
Comments: ____________

*Please be detailed about any GPS points not logged/delineation work still to be done.*
A.6 Mosquito Point Log Sheet

<table>
<thead>
<tr>
<th>Domain</th>
<th>Site</th>
<th>Morton Order</th>
<th>Plot ID</th>
</tr>
</thead>
</table>

### Plot Map: Mosquito Sampling Point

Plot Markers Used
- Primary Markers
  - Marked With: ______

**What to Record**
- Check off when markers installed. Note any offset markers.
- Sketch road location and give approx. distance.
- If possible, the point should be difficult to see from the road. Note any obstructions (big trees, boulders, etc.) that also may serve as landmarks to help find the sampling point.

#### Initial Establishment Visit

- Date Accepted: ________________
- Field Crew: __________________________
- Trimble GPS Used: ________________
- All GPS Points Attempted? □ Y / □ N
- Plot Nickname: ________________
- Plot Delineation Completed? □ Y / □ N
- Comments:
  
*Please be detailed about any GPS points not logged/delineation work still to be done.*
A.7 Tower Plot Log Sheet- 40m by 40m

PLOT MAINTENANCE LOG

Domain: Site: Morton Order: Plot ID: 

Plot Map: 40m by 40m Tower Base Plot

Plot Markers Used
🌟 Primary Markers
Marked With:

● Standard Secondary Markers
Marked With:

▲ Additional Secondary Markers for Div./Soils Tower Plots
Marked With:

☐ Optional Marker Positions
Marked With:

What to Record
- Check off positions where markers installed. Note any offset markers.
- Note pools, streams, boulders—anything that may complicate sampling.

Initial Establishment Visit
Date Accepted: Field Crew: 
Trimble GPS Used: All GPS Points Attempted? ☐ Y / ☐ N
Plot Nickname: Plot Delineation Completed? ☐ Y / ☐ N
Comments:

Please be detailed about any GPS points not logged/delineation work still to be done.
A.8 Tower Plot Log Sheet- 20m by 20m

PLOT MAINTENANCE LOG

Domain: _______ Site: _______ Morton Order: _______ Plot ID: _______

Plot Map: 20m by 20m Tower Base Plot

Plot Markers Used
- Primary Markers
  Marked With: _______
- Standard Secondary Markers
  Marked With: _______
- Additional Secondary Markers for Div./Soils Tower Plots
  Marked With: _______
- Optional Marker Positions
  Marked With: _______

What to Record
- Check off positions where markers installed. Note any offset markers.
- Note pools, streams, boulders—anything that may complicate sampling.

Initial Establishment Visit

Date Accepted: _______ Field Crew: _______
Trimble GPS Used: _______ All GPS Points Attempted? □ Y / □ N
Plot Nickname: _______ Plot Delineation Completed? □ Y / □ N
Comments:

Please be detailed about any GPS points not logged/delineation work still to be done.
### PLOT MAINTENANCE LOG

**Domain:** __________  **Site:** __________  **Morton Order:** __________  **Plot ID:** __________

#### Plot Map: Phenology Plot

![Plot Map Diagram]

#### Plot Markers Used

- **Primary Markers**
  - Marked With: __________
- **Standard Secondary Markers**
  - Marked With: __________

#### What to Record

- Check off positions where markers installed. For secondary phenocam transects this will be 3 markers max. Note any offset markers.
- Note pools, streams, boulders—anything that may complicate sampling.
- The Phenocam Plot only needs markers at the SW, S, and SE points

### Initial Establishment Visit

**Date Accepted:** __________  **Field Crew:** __________

**Trimble GPS Used:** __________  **All GPS Points Attempted?** □ Y / □ N

**Plot Nickname:** __________  **Plot Delineation Completed?** □ Y / □ N

**Comments:**

Please be detailed about any GPS points not logged/delineation work still to be done.
## A.10 Marker Installation Log Sheet

### “Permanent” Marker Installation
Date Installed: ___________  Field Crew: ________________
Comments (for example, offsets used?):

### Maintenance Visit
Date: ___________  Field Crew: _______________________
Maintenance Issue and Resolution:

### Maintenance Visit
Date: ___________  Field Crew: _______________________
Maintenance Issue and Resolution:

### Maintenance Visit
Date: ___________  Field Crew: _______________________
Maintenance Issue and Resolution:

### Maintenance Visit
Date: ___________  Field Crew: _______________________
Maintenance Issue and Resolution:

### Maintenance Visit
Date: ___________  Field Crew: _______________________
Maintenance Issue and Resolution:
APPENDIX B GPS RECEIVER SETUP

B.1 GeoXH 6000 & Terra Sync version 5.11

![Figure 32. GPS receiver Geo XH 6000](image)

1. Turn GPS receiver on by pushing the green power button below the screen. Once the unit is on, in the screen, look for the Windows start icon in the lower-left side of the screen.
2. Initialize the Terra Sync software located in the Start menu of the High Resolution GPS unit.
3. Adjusting GPS Time

   On the first day of work at a site, make sure that the GPS unit Time Zone, Date and Time are appropriate to the location where the measurements will be collected. See instructions below:
   - Click on the time stamp at the top right of the screen. A pop up bar will appear underneath.
   - Click on the clock icon
   - Adjust the time Zone, Date, and Time
   - Click on the box for Sync to current time zone
   - Click OK
4. Setup Menu

Logging Settings

In the upper-left corner at the MDD menu select Setup, tap on Logging Settings:

a. In Accuracy Settings tap on the wrench icon and make sure the Accuracy Values For Display/Logging settings are:
   1) Horizontal
   2) Postprocessed
   3) Postprocessing Base Distance:
• Obtain this information from the table below.
<table>
<thead>
<tr>
<th>Domain</th>
<th>Site</th>
<th>Code</th>
<th>Distance to Base Station (km)</th>
<th>UTM (N)</th>
<th>Datum</th>
</tr>
</thead>
<tbody>
<tr>
<td>D01</td>
<td>Harvard Forest</td>
<td>HARV</td>
<td>&lt;80</td>
<td>18</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D01</td>
<td>Bartlett Experimental Forest</td>
<td>BART</td>
<td>&lt;80</td>
<td>19</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D02</td>
<td>Smithsonian Conservation Biology Institute</td>
<td>SCBI</td>
<td>&lt;80</td>
<td>17</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D02</td>
<td>Smithsonian Environmental Research Center</td>
<td>SERC</td>
<td>&lt;80</td>
<td>18</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D02</td>
<td>Blandy Experimental Farm</td>
<td>BLAN</td>
<td>&lt;80</td>
<td>17 (tower), 18 (distributed)*</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D03</td>
<td>Ordway-Swisher Biological Station</td>
<td>OSBS</td>
<td>&lt;80</td>
<td>17</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D03</td>
<td>Disney Wilderness Preserve</td>
<td>DSNY</td>
<td>&lt;80</td>
<td>17</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D03</td>
<td>Jones Ecological Research Center</td>
<td>JERC</td>
<td>&lt;80</td>
<td>16</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D04</td>
<td>Guanica Forest</td>
<td>GUAN</td>
<td>&lt;80</td>
<td>19</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D04</td>
<td>Lajas Experimental Station</td>
<td>LAJA</td>
<td>&lt;80</td>
<td>19</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D05</td>
<td>UNDERC</td>
<td>UNDE</td>
<td>&lt;80</td>
<td>16</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D05</td>
<td>Steigerwaldt Land Services</td>
<td>STEI</td>
<td>&lt;200</td>
<td>15 (tower), 16 (distributed)*</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D05</td>
<td>Treehaven</td>
<td>TREE</td>
<td>&lt;200</td>
<td>16</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D06</td>
<td>Konza Prairie Biological Station</td>
<td>KONZ</td>
<td>&lt;80</td>
<td>14</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D06</td>
<td>The University of Kansas Field Station</td>
<td>UKFS</td>
<td>&lt;80</td>
<td>15</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D06</td>
<td>Konza Prairie Biological Station</td>
<td>KONA</td>
<td>&lt;80</td>
<td>14</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D07</td>
<td>Oak Ridge</td>
<td>ORNL</td>
<td>&lt;80</td>
<td>16</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D07</td>
<td>Mountain Lake Biological Station</td>
<td>MLBS</td>
<td>&lt;80</td>
<td>17</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D07</td>
<td>Great Smoky Mountains National Park, Twin Creeks</td>
<td>GRSM</td>
<td>&lt;80</td>
<td>17</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D08</td>
<td>Talladega National Forest</td>
<td>TALL</td>
<td>&lt;80</td>
<td>16</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D08</td>
<td>Dead Lake</td>
<td>DELA</td>
<td>&lt;80</td>
<td>16</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D08</td>
<td>Lenoir Landing</td>
<td>LENO</td>
<td>&lt;80</td>
<td>16</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D09</td>
<td>Woodworth</td>
<td>WOOD</td>
<td>&lt;200</td>
<td>14</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D09</td>
<td>Dakota Coteau Field School</td>
<td>DCFS</td>
<td>&lt;200</td>
<td>14</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D09</td>
<td>Northern Great Plains Research Laboratory</td>
<td>NOGP</td>
<td>&lt;80</td>
<td>14</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D10</td>
<td>Central Plains Experimental Range</td>
<td>CPER</td>
<td>&lt;80</td>
<td>13</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>D10</td>
<td>North Sterling, CO</td>
<td>STER</td>
<td>&lt;80</td>
<td>13</td>
<td>WGS 1984</td>
</tr>
</tbody>
</table>
BLAN and STEI boundaries cross UTM zones. Since they are so close to the border it is fine to use one UTM zone for the entire site.

4) Base Data: select **GPS+GLONASS**
5) Use Accuracy-based Logging: select **Yes**
6) Apply Accuracy-based Logging To: **Point Features and Vertices**
7) Required Accuracy: **50cm**
8) Tap **Done** located in the lower left area of the screen

b. Point/Vertex Auto-pause Count: tap on **None**

c. Antenna Height, tap on the wrench ( ![wrench](image)) and modify the following to:
   1) Antenna Height: **1m**
   2) Confirm: **Per File**
3) Type: select the appropriate antenna, when setting up the unit for hiking, select the internal antenna.

4) Part Number:

5) Measure Height to: bottom of receiver

6) Tap **Done**

d. Allow Position Update: tap on **Confirm**

e. Confirm End Feature: select **No**

f. Filename Prefix:

1) Refer to SOP 7.1B.3 to determine the what the first nine characters of the filenames for the site where you will be working, which will take the form of **D##_SITE_**. Since the first part of the filename will not change, this may be set this as your prefix to save time in the field.

   a) For example, Domain 02 working at SCBI would use the prefix **D02_SCBI_**.

2) Optional: Placeholder text can be used to indicate the required file name format (see SOP 7.1B.3). Items beyond the four-letter site code can then be replaced with plot-specific text in the field.

   a) For example: **D02_SCBI_Morton##_plotType_GPS_V##**.

g. Waypoint Filename Prefix: **W**

h. Between Feature Logging:

   1) Style: Time

   2) Interval: **off**

   i. Tap **Done** at the bottom left side of the screen.

**GNSS Settings**

Tap on GNSS Settings:

a. GNSS Receiver Port: **COM3**

b. Check on the box for **Use Smart Settings**

c. NMEA Output: **OFF**

d. Tap **Done** located in the lower left area of the screen
Real-time Settings

Tap on Real-time Settings:

a. Choice 1: tap on **Use Uncorrected GNSS**
b. Tap **Done**

Coordinate System

Tap on Coordinate System:

Select the coordinate system used for all shapefiles and imagery uploaded to the unit for a specific site.

a) System: obtain this information from (RD [20])- the NEON Configured Site List
b) Zone: obtain this information from (RD [20])- the NEON Configured Site List
c) Datum: obtain this information from (RD [20])- the NEON Configured Site List
d) Altitude Reference: **Mean Sea Level (MSL)**
e) Altitude Units: **Meters**
f) Display USNG: **OFF**
g) Coordinate Units: **Meters**
h) Coordinate order: **East/North**
i) Click **Done** located in the lower left area of the screen

Units

Tap on **Units**:

a. Distance Units: **Meters**
b. Area Units: **Square Meters**
c. Velocity Units: **Kilometers per hour**
d. Angle Units: **Degrees**
e. Lat/Long Format: **DD.ddd°**
f. Offset Format: **Horizontal/Vertical**
g. North Reference: **Magnetic Declination**
h. Magnetic Declination: Make sure that the declination is set on **auto**.

- Declination changes with time and space; as long as the GPS is in auto, it will update it automatically. Positive declination values are East, negative values are West. To verify the correct auto declination is set, obtain the current declination values for your location from [http://www.ngdc.noaa.gov/geomag-web/#declination](http://www.ngdc.noaa.gov/geomag-web/#declination).

External Sensors

5. Tap on **External Sensors**: uncheck all sensor check boxes. This concludes GPS settings. Unit can be shut down or brought to standby mode.
APPENDIX C    CRITERIA FOR PLOT ESTABLISHMENT IN WET LOCATIONS

Does the vegetation community contain > 50% local hydric plant species?  
Ask the staff botanist

Yes          No

Determine whether or not standing water will be present year-to-year  
(i.e., is this just a wet year?)

Yes          No

Is > 50% of the plot area covered by standing water > 30 cm in depth?

Yes          No

Reject Plot location          Continue to plot establishment and issue JIRA ticket regarding acceptable protocols          Continue with plot establishment
APPENDIX D  PLOT ESTABLISHMENT WORKFLOWS

D.1  Overall field steps

- Compile all Equipment and Materials \textit{SOP A}
- Navigate to preloaded point \textit{SOP B}
- Complete NLCD canopy cover assessment
- Does the vegetation at the plot match the expected vegetation class? \textit{SOP B} Complete logistical validation.
- NO
- Create a New Data File
  - Reject plot location, note the reason, choose next plot from RRQRR list. \textit{SOP B}
- YES
- Create a New Data File
  - Record metadata in data dictionary \textit{SOP B}
- Is the plot a tower or distributed plot?
- Tower
  - Perform Tower plot Delineation and Monumentation for:
    - Plant Productivity or Phenology. \textit{SOP C}
- Distributed
  - Perform Distributed plot Delineation and Monumentation for:
    - Base, Small Mammals, Birds or Ticks. \textit{SOP C}
  - Conduct GPS Coordinate Collection. \textit{SOP D}
  - Check for co-located plots. Pull flags and tape, navigate to next preloaded potential plot origin.
D.2 Tower Plot Workflow

Type: Tower
Subtype: Base Plot

- Locate Centroid
- Complete validation and fill out metadata
- Mark Centroid

- Forest vegetation plot
- Grassland/agricultural vegetation

- Delineate a 40 X 40 m plot
- Delineate a 20 X 20 m plot

★ Primary Marker label PlotID (e.g. CPER_001) and PointID (e.g. 41)
- Secondary Marker label all markers with corresponding PointID numbers, see above (e.g. 57)
- Photos taken towards plot centroid

Collect high resolution GPS coordinates for all points
Type: Tower
Subtype: Base Plot

Only for a subset of tower plots that will measure: Biogeochemistry, Microbe, Plant Diversity and Plant Productivity

1. Locate Centroid
2. Complete validation and fill out metadata
3. Mark Centroid

Forest vegetation plot
- Delineate a 40 X 40 m tower plot
- And 20 x 20 m plot

Grassland/agricultural vegetation
- Delineate a 20 X 20 m plot
- And 40 x 40 m corners

★ Primary Marker label PlotID (e.g. CPER_001) and PointID (e.g. 41)
★ Secondary Marker label all markers with corresponding PointID numbers, see above (e.g. 57)
★ Photos taken towards plot centroid

Collect high resolution GPS coordinates for all points
D.3 Phenology Plot - Primary

Type: Tower
Subtype: Phenology Plot

Use preloaded data to locate and mark all points

Fill out metadata

Final plot is 200 x 200 m

- **Primary Marker** label `PlotID` (e.g. CPER_001) and `PointID` (SW, NE)
- **Secondary Marker** label all markers with corresponding `PointID` cardinal directions, see above (e.g. NW)
- Take photos towards next point on transect in a clockwise direction

Collect High resolution GPS coordinates for all points
D.4 Phenology Plot - Phenocam

Type: Tower
Subtype: Phenology Plot
Secondary Plot if applicable - Phenocam

Use preloaded data to locate and mark all points

Fill out metadata

Final plot is 200 m

Primary Marker label PlotID (e.g. CPER_001) and PointID (SW)
Secondary Marker label all markers with corresponding PointID cardinal directions, see above (e.g. S)

Take photos towards next point on transect in clockwise fashion. SW photo taken towards S point.

Collect GPS coordinates for all points
D.5 Distributed, Distributed Base Plot Workflow

Type: Distributed
Subtype: Base Plot

1. Locate Centroid
2. Complete validation and fill out metadata
3. Mark Centroid
4. Delineate Plot
   - Inner plot 20 x 20 m
   - Outer plot 40 x 40 m

- **Primary Marker** label PlotID (e.g. CPER_001) and PointID (e.g. 41)
- **Secondary Marker** label all markers with corresponding PointID numbers, see above (e.g. 57)
- Photos taken towards the centroid

Collect GPS coordinates for all points
D.6 Distributed, Tick Plot Workflow

Type: Distributed
Subtype: Tick Plot

- Locate Centroid
- Complete validation and fill out metadata
- Delineate Plot 40 x 40 m

★ Primary Marker label PlotID (e.g. CPER_001) and PointID (41, 21)
• Secondary Marker label all markers with corresponding PointID numbers, see above (e.g. 57)

Collect GPS coordinates for all corner points
D.7 Distributed, Small Mammal Grid Workflow

Type: Distributed
Subtype: Mammal Grid

1. Locate Centroid and 4 Corners
2. Fill out metadata
3. Mark Centroid and 4 Corners
4. Collect Centroid

- **Primary Marker** label PlotID (e.g. CPER_001) and PointID (E5)
- **Secondary Marker** label PointID (e.g. A1)

5. Set up
   - 100 x 100 m
   - (no GPS points required besides E5, follow instructions in small mammal protocol)
D.8 Distributed, Bird Grid Workflow

Type: Distributed
Subtype: Bird Grid

- Locate Centroid
- Mark Centroid
- Collect high resolution GPS coordinates for centroid

B2 ★

★ Primary Marker label PlotID (e.g. CPER_001) and PointID (B2)

- Final grid 500 x 500 m (no GPS points required besides centroid)

If the site is bird point sampling at a subset of Distributed Base Plots no additional markers are necessary
D.9 Distributed, Mosquito Point Workflow

Type: Distributed
Module: Mosquito Point

 Locate Point

 Shift point up to 10m if needed (point needs to be >5m from road)

 Validate the vegetation and fill out data dictionary

 Mark the point


Primary Marker label PlotID (e.g. CPER_001)

 Collect high resolution GPS coordinates for point
## APPENDIX E  NLCD VEGETATION CLASSIFICATION DESCRIPTION

<table>
<thead>
<tr>
<th>Class/Value</th>
<th>Classification Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>areas of open water or permanent ice/snow cover.</td>
</tr>
<tr>
<td>11 Open Water</td>
<td>areas of open water, generally with less than 25% cover of vegetation or soil.</td>
</tr>
<tr>
<td>12 Perennial Ice/Snow</td>
<td>areas characterized by a perennial cover of ice and/or snow, generally greater than 25% of total cover.</td>
</tr>
<tr>
<td>Developed</td>
<td>areas characterized by a high percentage (30% or greater) of constructed materials (e.g. asphalt, concrete, buildings, etc.).</td>
</tr>
<tr>
<td>21 Developed, Open Space</td>
<td>areas with a mixture of some constructed materials, but mostly vegetation in the form of lawn grasses. Impervious surfaces account for less than 20% of total cover. These areas most commonly include large-lot single-family housing units, parks, golf courses, and vegetation planted in developed settings for recreation, erosion control, or aesthetic purposes.</td>
</tr>
<tr>
<td>22 Developed, Low Intensity</td>
<td>areas with a mixture of constructed materials and vegetation. Impervious surfaces account for 20% to 49% percent of total cover. These areas most commonly include single-family housing units.</td>
</tr>
<tr>
<td>23 Developed, Medium Intensity</td>
<td>areas with a mixture of constructed materials and vegetation. Impervious surfaces account for 50% to 79% of the total cover. These areas most commonly include single-family housing units.</td>
</tr>
<tr>
<td>24 Developed High Intensity</td>
<td>highly developed areas where people reside or work in high numbers. Examples include apartment complexes, row houses and commercial/industrial. Impervious surfaces account for 80% to 100% of the total cover.</td>
</tr>
<tr>
<td>Barren</td>
<td>areas characterized by bare rock, gravel, sand, silt, clay, or other earthen material, with little or no &quot;green&quot; vegetation present regardless of its inherent ability to support life. Vegetation, if present, is more widely spaced and scrubby than that in the green vegetated categories; lichen cover may be extensive.</td>
</tr>
<tr>
<td>31 Barren Land (Rock/Sand/Clay)</td>
<td>areas of bedrock, desert pavement, scarps, talus, slides, volcanic material, glacial debris, sand dunes, strip mines, gravel pits and other accumulations of earthen material. Generally, vegetation accounts for less than 15% of total cover.</td>
</tr>
<tr>
<td>Forest</td>
<td>areas characterized by tree cover (natural or semi-natural woody vegetation, generally greater than 5 meters tall); tree canopy accounts for 20% to 100% of the cover.</td>
</tr>
<tr>
<td>41 Deciduous Forest</td>
<td>areas dominated by trees generally greater than 5 meters tall, and greater than 20% of total vegetation cover. More than 75% of the tree species shed foliage simultaneously in response to seasonal change.</td>
</tr>
<tr>
<td>42 Evergreen Forest</td>
<td>areas dominated by trees generally greater than 5 meters tall, and greater than 20% of total vegetation cover. More than 75% of the tree species maintain their leaves all year. Canopy is never without green foliage.</td>
</tr>
<tr>
<td>43 Mixed Forest</td>
<td>areas dominated by trees generally greater than 5 meters tall, and greater than 20% of total vegetation cover. Neither deciduous nor evergreen species are greater than 75% of total tree cover.</td>
</tr>
</tbody>
</table>
### Class/Value | Classification Description
--- | ---
**Shrubland** | areas characterized by natural or semi-natural woody vegetation with aerial stems, generally less than 5 meters tall, with individuals or clumps not touching to interlocking. Both evergreen and deciduous species of true shrubs, young trees, and trees or shrubs that are small or stunted because of environmental conditions are included.

51 **Dwarf Scrub** - Alaska only areas dominated by shrubs less than 20 centimeters tall with shrub canopy typically greater than 20% of total vegetation. This type is often co-associated with grasses, sedges, herbs, and non-vascular vegetation.

52 **Shrub/Scrub** - areas dominated by shrubs; less than 5 meters tall with shrub canopy typically greater than 20% of total vegetation. This class includes true shrubs, young trees in an early successional stage or trees stunted from environmental conditions.

**Herbaceous** | areas characterized by natural or semi-natural herbaceous vegetation; herbaceous vegetation accounts for 75% to 100% of the cover.

71 **Grassland/Herbaceous** - areas dominated by graminoid or herbaceous vegetation, generally greater than 80% of total vegetation. These areas are not subject to intensive management such as tilling, but can be utilized for grazing.

72 **Sedge/Herbaceous** - Alaska only areas dominated by sedges and forbs, generally greater than 80% of total vegetation. This type can occur with significant other grasses or other grasslike plants, and includes sedge tundra, and sedge tussock tundra.

73 **Lichens** - Alaska only areas dominated by fruticose or foliose lichens generally greater than 80% of total vegetation.

74 **Moss** - Alaska only areas dominated by mosses, generally greater than 80% of total vegetation.

**Planted/Cultivated** | areas characterized by herbaceous vegetation that has been planted or is intensively managed for the production of food, feed, or fiber; or is maintained in developed settings for specific purposes. Herbaceous vegetation accounts for 75% to 100% of the cover.

81 **Pasture/Hay** – areas of grasses, legumes, or grass-legume mixtures planted for livestock grazing or the production of seed or hay crops, typically on a perennial cycle. Pasture/hay vegetation accounts for greater than 20% of total vegetation.

82 **Cultivated Crops** – areas used for the production of annual crops, such as corn, soybeans, vegetables, tobacco, and cotton, and also perennial woody crops such as orchards and vineyards. Crop vegetation accounts for greater than 20% of total vegetation. This class also includes all land being actively tilled.

**Wetlands** | areas where the soil or substrate is periodically saturated with or covered with water as defined by Cowardin et al., (1979).

90 **Woody Wetlands** - areas where forest or shrubland vegetation accounts for greater than 20% of vegetative cover and the soil or substrate is periodically saturated with or covered with water.

95 **Emergent Herbaceous Wetlands** - Areas where perennial herbaceous vegetation accounts for greater than 80% of vegetative cover and the soil or substrate is periodically saturated with or covered with water.
APPENDIX F  PLOT DELINEATION LAYOUT

Use the following schematics in the field to keep track of your progress, place diagram in page protector, and mark off points with a dry erase as you locate them. Rounded corners indicate where tape is wrapped.

F.1  Tower Plot – 40x40 meters

![Diagram of Tower Plot - 40x40 meters]
F.2 Tower Plot – 20x20 meters

- **Primary plot marker**
- **Secondary plot marker**

---

- **Rangefinder/Compass + Tape**

---

Centroid

14.14 m

10 m

20 m

North (N) 360°

East (E) 90°

South (S) 180°

West (W) 270°

North West (NW) 315°

North East (NE) 045°

South West (SW) 225°

South East (SE) 135°
APPENDIX G  SCHEMATIC OF COMPLETE GRID USED TO LABEL PLOT POINTS

Figure 33. Schematic of the point ID grid
APPENDIX H  TROUBLESHOOTING

H.1   GPS

- The unit shuts down on its own:
  - Click on the Power button once to check if it is on standby mode. If it were on standby it should turn on once
  - Restart the unit by pressing on the Power button and check the battery, if the battery is low,
  - Replace the battery with a fully charged extra battery

- TerraSync map display is incorrect:
  - Tap with the stylus on MDD>Setup, then tap on coordinate system and make sure the coordinate system, zone, and datum are correct.
  - If the map doesn’t display correctly check the .imp file coordinate system by locating the .txt file located in the shared folder where the .imp file is locate on the computer.
  - Click on the .txt files in the corresponding folder and find the one that displays the .imp file in use and check the output data coordinate system, zone and datum. If the coordinate system is incorrect, the file will have to be imported again into Pathfinder with the corrected coordinate system.

- Accidentally clicked on the camera button:
  - Click OK to the bottom right of the screen.
  - Click on the ‘X’ symbol to the bottom right of the screen, the next screen should be the TerraSync working screen
H.2 Plot Establishment Obstructions

- Large trees, rocks or over/below brush

If there are obstructions (i.e. large tree, rocks...) between Person 1 & Person 2 when using the rangefinder to place a marker or make measurements:

  - Use the Rangefinder 360R in HD mode to accurately measure 10m of horizontal distance along the slope. Depending on the degree of slope, using the transect tape could result in moving the flag to 10.5 m instead of 10 m. If this is performed along the center line, this adjustment should be propagated through the remaining points on that line (i.e. 20.5, 30.5 etc.). Using the Rangefinder in filter mode and shooting at a reflector can help determine where exactly to place the flag.
  - Both people can step to the side up to 3 times away from the point or use an alternative standardized measurement to get a clear reading. Once a clear reading is acquired move back to the original point and place marker.

![Diagram](image)

**Figure 34.** Alternative strategy when obstructions are in line of sight during plot delineation

  - If low/high stature obstructions are encountered between Person 1 & person 2 when using the tape, pull the tape up/down on both ends and measure above/below the obstruction; make sure to use the rangefinder to verify results.
• Plot verification obstructions
  - When looking for a line of sight for verification, if the initial suggested diagonal line of sight is obstructed, use the Pythagorean Theorem $c^2 = b^2 + a^2$ to find the unobstructed hypotenuse of a right triangle within the plot to complete the verification. For example, if there is a line of obstruction for verification of point 49 from point 41 when delineating a 20 by 20 meter plot, there are several hypotenuse options (see Figure 19). Select the one that is clear of obstructions and use it to verify point. Calculate the hypotenuse distance with the base and the height of the right triangle; in this case using the right triangle between points 49, 31 and 32 the hypotenuse “c” would be:

\[
  c^2 = b^2 + a^2 \\
  c = \sqrt{b^2 + a^2} \\
  c = \sqrt{20^2 + 10^2} \\
  c = \sqrt{500} \\
  c = 22.36 \text{ meters}
\]

In order to verify point 49 from point 32 the distance measured with both the tape and the range finder should be 22.36 meters.

![Figure 35. Hypotenuse option to verify plot delineation measurements](image-url)
APPENDIX I   PLOT MONUMENT INSTALLATION JSA

DESCRIPTION OF JOB TASK: As required in the TOS Protocol and Procedure for Plot Establishment, up to two permanent monuments will be installed at all distributed and tower plots where the site host has approved such monumentation. The permanent markers generally consist of one or more sections of aluminum rods, a top cap stamped with information related to the point and plot, and a bottom spike to facilitate driving the rod into the ground.

<table>
<thead>
<tr>
<th>Item</th>
<th>JOB STEP SEQUENCE</th>
<th>POTENTIAL HAZARDS</th>
<th>RECOMMENDED SAFE PRACTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Travel to jobsite. Before work begins, review steps of this procedure with workers. Inspect worksite for hazards.</td>
<td>Improper use or failure of equipment can cause serious injury or property damage. Driving, Bees/Wasps, Ice, Trips, etc.</td>
<td>Before the work starts, the crew must be aware of the potential hazards associated with the task. The team must also be aware of the intended safe procedures and the appropriate PPE to be worn during the operation. Journey Management and Vehicle safety best practices should be followed.</td>
</tr>
<tr>
<td>2</td>
<td>Inspect and put on personal protective equipment.</td>
<td>Failure to identify worn PPE. Improper use of PPE.</td>
<td>Personnel should inspect PPE before use. It is the end user’s responsibility to ensure PPE is in functional condition before beginning work.</td>
</tr>
<tr>
<td>3</td>
<td>Remove old temporary markers.</td>
<td>Strain on back.</td>
<td>Use crowbar to gain leverage to reduce strain on back.</td>
</tr>
<tr>
<td>4</td>
<td>Build Permanent Marker segments.</td>
<td>Segments could loosen, causing marker to bend, leading to a missed blow with the T-post driver.</td>
<td>Use pliers or a wrench with teeth to tighten each segment and driving adapter before being to pound marker with T-post driver.</td>
</tr>
<tr>
<td>5</td>
<td>Drive Permanent Marker into the ground.</td>
<td>Loud noise, blisters on hand, crushing</td>
<td>Ear protection must be worn by both people on the plot. Thick, impact gloves must be worn by</td>
</tr>
<tr>
<td>6</td>
<td>Attach additional Permanent Marker segments until needed depth is reached.</td>
<td>Strain on back.</td>
<td>The person using the T-post driver. DO NOT lift the T-post driver above the scored marking line on the top section of the Permanent Marker while using the T-post driver. The second person on the plot should be watching the person using the T-post driver to ensure this does not happen. After every 6-12 blows with the T-post driver, check the connections of the marker segments and the driving adapter segments and the driving stud.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>7</td>
<td>Permanent Marker may need to be cut, if bedrock or difficult soil substrate is encountered. A battery powered reciprocating saw or hacksaw are the appropriate tools for this.</td>
<td>Cutting off finger, loud noise, hot metal shards in eyes or on hands.</td>
<td>Both people on the plot must wear safety glasses, gloves and hearing protection. When assembling the hand or power saw, be sure to have parts secured before beginning to cut the Permanent Marker. The second person on site should verify this before cutting begins. If both people are not comfortable using the sawzall then a hacksaw will be used instead.</td>
</tr>
<tr>
<td>8</td>
<td>Install Marker Cap</td>
<td>Strain on back, crushing hands.</td>
<td>Once the Permanent Marker has reached needed depth, remove excess segments installed to reduce back strain. Then install Marker Cap with a plastic sledge hammer.</td>
</tr>
</tbody>
</table>
APPENDIX J   BASE STATION WORKFLOW

Establishing a base station increases accuracy by providing more accurate data for post-processing. With
data originating closer (directly on) to a site, post processing of GPS data from field technicians is more
effective at reducing noise and eliminating interference which results in far greater accuracy in our GPS
data collection efforts. This gain in accuracy is often enough to see rejection rates reduced three fold.

Setting up a new monument is a straightforward process that must be done in proper order to ensure
good returns on all future GPS data collection. Setting up a new monument includes one 5+ hour day in
the field and at least 1 hour of internet connected computer post processing. Monumentation only
needs be done once and can be done days (or weeks) prior to a GPS measurement bout. Once the
monument is established, daily GPS collection bouts will follow the plot establishment protocol SOP D
with the addition of setting up the base station coverage in the morning, taking it down at the end of
the day, and transferring the base station data along with GPS files to Science.

Overall the workflow of using a base station is exactly the same whether establishing a new monument
from scratch or setting up over an established monument in preparation for collecting GPS data during
plot establishment. Because of this, the directions of each step in the workflow have been written out
into a single list of steps, with any workflow specific deviations noted.

Summary Workflow:

1) Monument setup (this is done just once per site):
   a. Set up new monument site.
   b. Collect base station data for at least 5+ hours (NO plot establishment measurement).
   c. Stop collection of data.
   d. Transfer data to handheld in field.
   e. Break down base station setup.
   f. Transfer data to computer.
   g. Process data with OPUS.
      i. Need an internet connection to complete this step.

2) Base station coverage:
   a. Set up on the established monument.
   b. Run base station coverage, starting survey.
   c. Collect GPS data for TOS plots following SOP D.
   d. Finish running base station coverage, ending survey.
   e. Transfer data to handheld in field.
   f. Break down base station setup.
g. Transfer data to computer.
h. Send both base station and Trimble data to science staff for post processing.

Detailed Instructions

The following equipment is needed to implement the procedures in this document. The list below only includes equipment needed to monument and the run the base station. Reference the equipment list in section 6 for supplies need to complete plot establishment.

Table 7. Base station equipment list

<table>
<thead>
<tr>
<th>Item No.</th>
<th>R/S</th>
<th>Description</th>
<th>Purpose</th>
<th>Quantity</th>
<th>Special Handling</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td></td>
<td>Trimble R10 GNSS Receiver</td>
<td>Rented- Portable GPS base station to facilitate cleaner differential correction during post processing</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Quick release, Tribrach, Lever Extension</td>
<td>Rented- Connects the R10 GNSS Receiver to the Tripod</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Trimble TSC3 Data Collector and Charger</td>
<td>Rented- Hand held data recorder</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Tripod, 2m Poles</td>
<td>Rented- Holds the R10 in a level position</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>R10 Battery Charger</td>
<td>Rented</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>R10 Batteries</td>
<td>Rented- Includes one back up battery</td>
<td>2</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Measuring Tape</td>
<td>Up to 5m, measure the height of the R10</td>
<td>1</td>
<td>N</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Stakes</td>
<td>Mark the monument location</td>
<td>1</td>
<td>N</td>
</tr>
</tbody>
</table>

R/S=Required/Suggested

A. Set up monument at site
   a. Choose ideal location:
• Clear, open with as large an unobstructed horizon as possible. The base station is only a good as its ability to get solid, clean data from GPS satellites. First choice should be an open field with no large trees blocking horizon. If not available, prioritize open canopy/lack of canopy cover.
• Safe, secure location where base station can be left for 5+ hours. If possible, place nearby to any tower construction happening during plot establishment.
• Easy to access. Every plot establishment day will begin with setting up the base station and end with taking it down. Additionally, it may be necessary to change batteries mid-day, therefore having easy access is paramount to completing multiple plots in a single day.
• If a site does not appear to have a good monumenting location, work with Science to determine where one should be placed or if, possibly, multiple monuments may be necessary. Multiple monuments may be required in particularly large sites where travel logistics change halfway through plot establishment (travel times, road access issues, etc.).

b. Place a marker in the ground to identify the monument. This should either be a large orange plastic stake or a metal marker stake. It is imperative that this marker be secure and not movable during the duration of plot establishment.
• The base station must be placed in exactly the same location every time in order to generate reliable data.
• If possible leave a permanent marker in for any future GPS collection efforts.
  1. If permanent markers are not allowed at the site use a temporary marker during plot establishment

c. Photograph marker location.

B. Set up the tripod
a. Set up the legs looking for cracks/soil to help stabilize the unit.
b. Extend the legs so that the top of the tripod should be about chin height.
c. Make sure the tripod is as level as possible before attaching the tri-bracket.
d. Attach the tri-bracket.
e. Use the eyepiece to make sure the unit is squarely over a marker you placed in the ground. If you cannot find the marker in the eyepiece, wiggle your foot around underneath the tripod to try to locate where the eyepiece is seeing.
f. Finish leveling the legs. Shift between leveling, making sure the eyepiece is aiming at the marker, and using the leveling screws on the tri-bracket. Remember that the “ring” on the leveling screws is the halfway mark if you need to reset the screws.
g. Attach the trimble base station, quick connecter (grey), and quick mount first as one unit (Shown below in order, left to right. The tri-bracket is the part on the right)
Figure 36. Base station equipment

h. Attach the base station unit to the tri-bracket.
i. Tighten all connections.

Figure 37. Base station setup.

j. Turn on the base station unit.
C. Run base station coverage
   a. Turn on the handheld unit.
   b. Create a new job.
      i. The naming convention is to name the job the date of that day’s work. The format is SITE_MMDDYY.
      ii. Set up the coordinate system.
          1. Use the selection library to choose the correct UTM system.
          2. We are using a gridProject height- should be ~100m of the average height of the site
             a. For the initial collection of base station data: This information will be provided by Science.
             b. For subsequent days after the base station data has been processed: Use the output from the OPUS solution (see below for more information about OPUS).
      3. Store the coordinate information.
         iii. No active map, line, etc needed.
   iv. If prompted, set log rate to 1 log per second.
   v. Press accept- the job is created.
      1. Once you set up one job the template can be re-used for additional jobs and will require no changes.

c. Start the survey
   i. Go to “Instrument” button.
   ii. Go to “GNSS function”.

Figure 38. Setting up a new job
1. The handheld should connect automatically with the base station through blue tooth.
   a. If difficulty connecting to the base station:
      i. Hit the config button.
      ii. Scroll down the list, tap and hold on the base station’s name (serial number), delete the connection, then repair it.
      iii. If a screen comes up that says “Passcode” hit next, no passcode is needed.
   iii. If you are correctly connected to the base station the “base mode” button should be orange (this sometimes only appears after logging has started).

1. Another check: On the main screen there will be some information about the base station and battery life
   a. Top battery is for the handheld receiver
   b. Bottom battery is for the base station
iv. In survey styles select “logging”.
   1. Key in point name: Monument_1.

3. It will ask you for a location.
   a. For the initial collection of base station data: press the “here”
      button to generate a location based on the base station’s
      current readings from GPS satellites.
      i. Note: this a VERY rough approximation of location and
         is only there as a placeholder until OPUS can return the
         real solution.
b. For subsequent days after the base station data has been processed: enter in the easting and northing provided by the OPUS email.

![Figure 42. Entering the spatial information](image)

4. Antenna height:
   a. Measure from the ground to the lever arm extension on the base station unit using the measuring tape.
      i. The lever arm extension is the black handle on the bottom of the black bar before the tri-bracket.
   b. Use the “units” dropdown menu on the side to select meters.
      v. Hit start.
      vi. If the base station’s down arrow is lit up it means it is storing data.
      vii. Power down the handheld (green button).

d. End the survey
   i. For the initial collection of base station data: Make sure the base station has run for at least 5 hours.
   ii. Verify the base station unit is still powered on.
   iii. Power on the handheld.
   iv. In the GNSS window select “end survey”.
      1. Do not turn off base station, you will need to transfer files first.
   v. NOTE: if the base station runs out of battery before ending the survey, DO NOT MOVE IT. Power it back up and end survey before moving. When it powers back on the unit will continue to log points. It is better to leave the tripod overnight (taking the base station unit with you) and giving it a fresh battery in the morning than trying to take the station back and powering it up elsewhere.
D. Transfer data

These first steps should be done in the field as soon as the survey is ended.

a. Connect the handheld receiver (in practice it should still be connected) to the base station (using the instrument button and steps described in the handheld receiver setup).

b. Import files.
   i. Choose the files you want to import.
   ii. Imports can take some time if the file is large (5-10 minutes).

c. Turn off the base station unit.

The following steps can be done back at domain HQ.

d. Use either a flash drive or connect the handheld receiver to the computer to transfer files over.
   i. Files will be saved in the handheld in folders labeled by each job title. These folders are created when each job is created.
   ii. If using a flash drive:
      1. Sometimes takes a minute to register the “harddisc” on the handheld receiver.
      2. Highlight the files you want to transfer, go to the menu>edit>copy.
      3. Paste into the open space in the harddisc screen.
   iii. If using the cable:
      1. Connect handheld to computer in same method as a regular trimble handheld.
      2. Once connected properly, find the device in “my computer”. It will act exactly like an external hard drive. No software needed (e.g. pathfinder office).
      3. Find the files you wish to transfer and just click and drag into “basestation” folder. This “basestation” folder should be located in the same place that standard .ssf trimble files are exported to.

e. Email the Science staff you are working with that all files are transferred.

E. Post processing the data.

This work can either be done by TOS spatial techs or, in the interest of speed, by FOPS technicians. All software is freely available and requires no special licenses. However, it is somewhat technical and can be overwhelming to those less familiar with the process. Work with your team lead or TOS spatial technician to determine who best to process this data. When setting up a new monument, the base station data will need to be converted to RINEX and then
processed with OPUS. When using the base station for differential correction of plot spatial data, the base station data need only be converted to RINEX. The executable for converting trimble data to the RINEX format can be found at this website, hosted by Trimble: http://www.trimble.com/support_trl.aspx?Nav=Collection-40773&pt=Trimble%20RINEX

a. Convert to RINEX.

i. Transfer base station GPS files to “basestation” folder in GPS_pathfinder_data area of FOPS GIS folder tree.

ii. Using Trimble executable, “Convert to RINEX”, open GPS files. They will have a .T02 extension.

   1. Note: this software will often appear greyed out when first opening, don’t be thrown off by the appearance.

![Figure 43. RINEX Conversion](image)

iii. Once opened, you can check the metadata regarding the collected base station GPS information. To convert to RINEX, go to “File” and select “Convert Files”.

---

**Figure 43. RINEX Conversion**

---
b. OPUS post processing
   i. Go to the OPUS website: https://www.ngs.noaa.gov/OPUS/
      1. Send the ".o" file created in the RINEX conversion to OPUS.
      2. In the OPUS drop downs:
         a. Select the antenna type.
         b. Copy antenna height from the Rinex file summary. This is “Antenna.offset.meters” in section 3 (the height will automatically be calculated from the antenna height even though we measured the lever height in the field).
      3. In options, selected “format standard and xml” for easier viewing.
      4. To begin process click “Upload to Static”.

c. Read the OPUS report to get monument location.
   i. Towards the bottom of the email, look for “UTM COORDINATES” (will be next to state plane coordinates).
1. Try copy/pasting into notepad for easier reading.

ii. Record Northing and Easting for use when starting surveys.

Figure 45. OPUS Report